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Important
The following functions are for reference only. Some series products may not support all the functions
listed below.

Cybersecurity Recommendations

1. Change Passwords and Use Strong Passwords

The number one reason systems get “hacked” is due to having weak or default passwords. It is
recommended to change default passwords immediately and choose a strong password whenever
possible. A strong password should be made up of at least 8 characters and a combination of special
characters, numbers, and upper and lower case letters.

2. Update Firmware
As is standard procedure in the tech-industry, we recommend keeping NVR, DVR, and IP camera
firmware up-to-date to ensure the system is current with the latest security patches and fixes.

“Nice to have” recommendations to improve your network security

1. Change Passwords Regularly
Regularly change the credentials to your devices to help ensure that only authorized users are able to
access the system.

2. Change Default HTTP and TCP Ports:

e Change default HTTP and TCP ports for systems. These are the two ports used to communicate and
to view video feeds remotely.

e These ports can be changed to any set of numbers between 1025-65535. Avoiding the default ports
reduces the risk of outsiders being able to guess which ports you are using.

3. Enable HTTPS/SSL.:
Set up an SSL Certificate to enable HTTPS. This will encrypt all communication between your devices
and recorder.

4. Enable IP Filter:
Enabling your IP filter will prevent everyone, except those with specified IP addresses, from accessing
the system.
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5. Change ONVIF Password:

On older IP Camera firmware, the ONVIF password does not change when you change the system’s
credentials. You will need to either update the camera’s firmware to the latest revision or manually
change the ONVIF password.

6. Forward Only Ports You Need:

e Only forward the HTTP and TCP ports that you need to use. Do not forward a huge range of numbers
to the device. Do not DMZ the device's IP address.

e You do not need to forward any ports for individual cameras if they are all connected to a recorder on
site; just the NVR is needed.

7. Disable Auto-Login on SmartPSS:

Those using SmartPSS to view their system and on a computer that is used by multiple people should
disable auto-login. This adds a layer of security to prevent users without the appropriate credentials
from accessing the system.

8. Use a Different Username and Password for SmartPSS:

In the event that your social media, bank, email, etc. account is compromised, you would not want
someone collecting those passwords and trying them out on your video surveillance system. Using a
different username and password for your security system will make it more difficult for someone to
guess their way into your system.

9. Limit Features of Guest Accounts:
If your system is set up for multiple users, ensure that each user only has rights to features and
functions they need to use to perform their job.

10. UPnP:

e UPnP will automatically try to forward ports in your router or modem. Normally this would be a good
thing. However, if your system automatically forwards the ports and you leave the credentials defaulted,
you may end up with unwanted visitors.

e If you manually forwarded the HTTP and TCP ports in your router/modem, this feature should be
turned off regardless. Disabling UPnP is recommended when the function is not used in real
applications.

11. SNMP:
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Disable SNMP if you are not using it. If you are using SNMP, you should do so only temporarily, for
tracing and testing purposes only.

12. Multicast:
Multicast is used to share video streams between two recorders. Currently there are no known issues
involving Multicast, but if you are not using this feature, deactivation can enhance your network security.

13. Check the Log:

If you suspect that someone has gained unauthorized access to your system, you can check the system
log. The system log will show you which IP addresses were used to login to your system and what was
accessed.

14. Physically Lock Down the Device:
Ideally, you want to prevent any unauthorized physical access to your system. The best way to achieve
this is to install the recorder in a lockbox, locking server rack, or in a room that is behind a lock and key.

15. Connect IP Cameras to the PoE Ports on the Back of an NVR:
Cameras connected to the PoE ports on the back of an NVR are isolated from the outside world and
cannot be accessed directly.

16. Isolate NVR and IP Camera Network

The network your NVR and IP camera resides on should not be the same network as your public
computer network. This will prevent any visitors or unwanted guests from getting access to the same
network the security system needs in order to function properly.

Electrical safety

® All installation and operation should conform to your local electrical safety codes.

® The power source shall conform to the requirement of the Safety Extra Low Voltage (SELV)
standard, and supply power with voltage rated by DC 12 V or AC 24 V according to the Limited
power Source requirement of IEC60950-1. Please note that the power supply requirement is
subject to the device label.

® Make sure the power supply is correct before operating the device.

A readily accessible disconnect device shall be incorporated in the building installation wiring

® Prevent the power cable from being trampled or pressed, especially the plug, power socket and the
junction extruded from the device.

® We assume no liability or responsibility for all the fires or electrical shock caused by improper
handling or installation.

Vi
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Environment

® Do not aim the device at strong light to focus, such as lamp light and sun light, otherwise it might
cause over brightness or light marks, which are not the device malfunction, and affect the longevity
of Charge Coupled Device (CCD) or Complementary Metal-Oxide Semiconductor (CMOS).

® Do not place the device in a damp or dusty environment, extremely hot or cold temperatures, or the

locations with strong electromagnetic radiation or unstable lighting.

Keep the camera away from water or other liquid to avoid damages to the internal components.

Keep the indoor device away from rain or damp to avoid fire or lightning.

Keep sound ventilation to avoid heat accumulation.

Transport, use and store the device within the range of allowed humidity and temperature.

Heavy stress, violent vibration or water splash are not allowed during transportation, storage and

installation.

® Pack the device with standard factory packaging or the equivalent material when transporting the
device.

Privacy Protection Notice

As the device user or data controller, you might collect personal data of others' such as face,
fingerprints, car plate number, Email address, phone number, GPS and so on. You need to be in
compliance with the local privacy protection laws and regulations to protect the legitimate rights
and interests of other people by implementing measures include but not limited to: providing clear
and visible identification to inform data subject the existence of surveillance area and providing
related contact.

About the Manual

® The Manual is for reference only. If there is inconsistency between the Manual and the actual
product, the actual product shall govern.

® \We are not liable for any loss caused by the operations that do not comply with the Manual.

® The Manual would be updated according to the latest laws and regulations of related regions. For
detailed information, see the paper User's Manual, CD-ROM, QR code or our official website. If
there is inconsistency between paper User's Manual and the electronic version, the electronic
version shall prevail.

® All the designs and software are subject to change without prior written notice. The product updates
might cause some differences between the actual product and the Manual. Please contact the
customer service for the latest program and supplementary documentation.

® There still might be deviation in technical data, functions and operations description, or errors in
print. If there is any doubt or dispute, please refer to our final explanation.

Vi
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® Upgrade the reader software or try other mainstream reader software if the Guide (in PDF format)

cannot be opened.
® All trademarks, registered trademarks and the company names in the Manual are the properties of

their respective owners.
® Please visit our website, contact the supplier or customer service if there is any problem occurred

when using the device.
e If there is any uncertainty or controversy, please refer to our final explanation.

viii
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1 Product Overview

The common networking mode for IPC is to connect IPC to PC via switch or router. The common
network mode is shown in Figure 1-1.

Cable
Switch or Router

IPC

Figure 1-1

Before you have access to network camera via the Internet, you need to acquire its IP address. Users
can search IP address of network camera via Quick Config Tool.
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2 Initial Config

In this chapter it is to introduce the device initial config operation, which includes device initialization,
login device, log out WEB interface and password reset.

2.1 Device Initialization

It needs to implement device initialization when you use the device for the first time. Here it is to take
WEB operation as an example to introduce device initialization. You can also initialize device via Quick
Config Tool, NVR and platform etc.

Note

In order to guarantee device safety, please keep admin login password properly after device
initialization, and modify the password regularly.

Step 1

Open IE browser, input camera IP address in the address bar and click Enter.

The system will display the interface of Device Initialization after it is connected successfully, which is
shown in Figure 2-1.

Note

The default IP address is 192.168.1.108.

Device Initialization

Username admin

Password The minimum pass phrase length is 8 characters

Confirm Password

Use a password that has 8 to 32 characters, it can be a combination of letter(s),
number(s) and symbol(s) with at least two kinds of them.(please do notuse

special symbols like*™;: &)

[v] Email Address
To reset password, please input properly or update in time.

Save

Figure 2-1

Step 2
It is to set admin login password, please refer to Table 2-1 for more details.
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Parameter Note
User name The default user name is admin
Password The password ranges from 8 to 32 digitals. It can contain letters, numbers
Confirm and special characters (excluding “”,“",*”,*.”,“&”) . The password shall
assword contain at least two categories. Usually we recommend the strong
P password.
Input an email address for reset password purpose. In case you forgot
Email password in the future, input the security code you got on the assigned
email to reset the password of admin.
Table 2-1
Step 3
Click Save.

The system will display the interface of End-User License Agreement, which is shown in Figure 2-2.

End-User License Agreement

DAHUA SOFTWARE LICENSE AGREEMENT

mf »

1. PREAMBLE

IMPORTANT MOTICE, PLEASE READ CAREFULLY:

1.1 This Agreement is a Software License Agreement between you and Zhejiang Dahua Technology Co., Ltd. (hereinafter referred to
as "Dahua”). Please read this software license agreement (Agreement) carefully before using the Software. By using Dahua
Software, you are deemed to agree to be bound by the terms of this Agreement. If you do not agree to the terms of this Agreement,
please do notinstall or use the Software, and click the "disagree” button(lf there is any provision for "agree” or "disagree”). If the
Software you get is purchased as part of Dahua device, and you do not agree to the terms of this Agreement, you may return this
device/Software within the return period to Dahua or authorized distributor where you purchased from for a refund, but it should be
subject to the Dahua's return policy.

1.2 Consentto use of data

Wour narcnnal informatinn_includinatha namea nhona numbar |IP addrace and amail addrace aftha near me-aw ha ranuirad in ardar

I have read and agree to all terms

Figure 2-2

Step 4
Select | have read and agree to all terms and click Next.
The system will display the interface of P2P, which is shown in Figure 2-3.
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P2P

V| P2P
To assist you in remotely managing your device, the P2P will be enabled. After enabling P2P and connecting to Internet, we need to
collect IP address, MAC address, device name, device SM, etc. All collected info is used only for the purpose of remote access. If you

don't agree to enable P2P function, please deselect the check box.

Scan and Download APP

MNext

Figure 2-3

Step 5

Select P2P according to actual needs and realize P2P registration for device, click next. The system will

display the interface of Online Upgrade, which is shown in Figure 2-4
Online Upgrade

7] Auto-check for updates

Automatically notify me when updates are available. The system checks for updates daily.

Toinform you of the latest firmware upgrades for your device, we need to collect device info such as IP address, device name,
firmware version, device SN, etc. All collected info is used only for the purposes of verifying device validity and pushing upgrade

notifications.

Save

Figure 2-4

Step 6
It is to set upgrade method according to the actual requirements.
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Select Auto-check for upgrade and the system will check once daily automatically when there is system
upgrade prompt.
Note
After login, you can make setting in ‘Setup > System > Upgrade > Online Upgrade’.

Step 7
Click Save and device initialization is completed.

2.2 Login and Logout

Here it is to introduce device login and WEB interface logout via browser, it is to take IE Explorer 8 as

an example to make introduction.

2.2.1 Log in WEB Interface

Users can make operations such as live, playback and config upon the device after logging in device

WEB interface via browser.

Note

® |t can log in WEB interface after device initialization is completed.

® |t will prompt to install plug-in when logging in the system for the first time, please download and
install plug-in according to prompt.

Step 1

Open IE browser, input camera IP address in the address bar and click Enter button.

The system will display the Login interface after it is successfully connected, which is shown in Figure

2-5.

Username:

Password; | Forgot password?

Login Cancel

Figure 2-5
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Step 2
Input the password of admin user.
Step 3
Click Login.
It will display the Live interface after it logged in successfully, which is shown in Figure 2-6.
Note
Different devices have different functions with different interface display; please refer to the actual
interface for more details.

@hua

Figure 2-6

2.2.2 Logout

Click Logout and return to WEB login interface. After logging in the device WEB, the system will
hibernate automatically if it fails to operate the device for a period of time. It can recover to normal
working status quickly after entering password.

2.3 Reset Password

Users can reset password via reserved email when you forget the password of admin user.

Step 1

Open IE browser, input camera IP address in the address bar and click Enter button.

The system will display the Login interface after it is successfully connected, which is shown in Figure
2-7.
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Figure 2-7

Step 2
Click Forgot password?
The Notice dialogue box displays. See Figure 2-8

Prompt E_

A In order to provide a secure password reset environment, we need to collactyour e-mail address, device MAC address, device SN, ete. All collected info is used only for the purposes of veritying device validity and sending a security code to you. Do you

agree and wantto continue the operation?

Figure 2-8
Step 3
Click OK.
The Reset the password interface displays. See Figure 2-9.
NOTE

By clicking OK, it means you are informed that some of your personal data might be collected to help
resetting the password, such as phone number, MAC address, and device serial number and so on.
Please read carefully to decide whether to authorize the collection activity.
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Reset the password(1/2)

SN: 2C04ABIYAZ00019

QR code:

Note(For admin only):

Option 1. Please download Easy4ip and then from
Me-Settings-Reset device password, scan the left
QR code.

Option 2. Please use an APP to scan the left QR
code to get special strings. And then send the
strings to support_rpwd@alobal.dahuatech.com.

The security code will be delivered to 1**@qq.com

Security code:

[ ] o]

Figure 2-9

Step 4

Reset login password.

Scan the QR code according to the interface prompt and acquire security code, then input the security

code which is received via your reserved email.

Caution

® Please use the security code to reset the password within 24 hours after you received the security
code via your reserved email. Otherwise the security code will be invalid.

® |If you fail to use security code for twice continuously, then the system will prompt that it fails to
acquire security code for the third time. It needs hardware to restore device default setting and
acquire security code again or wait for 24 hours and acquire it again if it needs to use the device
normally.

Step 5

Click next.

The system will display the interface where you can set the new password, which is shown in Figure

2-10.
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Reset the password(2/2)

Username admin

Password

Use a password that has 8 to 32 characters, it
can be a combination of letter(s), number(s) and
symbol(s) with at least two kinds of them.
(please do not use special symbols like "™ ;: &)

Confirm Password

| Cancel I | Save l

Figure 2-10

Step 6

Reset Password and Confirm Password.

The password ranges from 8 to 32 digitals. It can contain letters, numbers and special characters
(excluding “”,“"%”“" “&”) . The password shall contain at least two categories. Usually we recommend
the strong password.

Step 7

Click Save and complete password reset.

The system will display the Login interface.
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3 Live

After you logged in, you can see the live monitor window. See Figure 3-1.

@lhua

CEEE T 1)

1 | | Main St substeami N substeamz [EreEdTCP |

4 & 0w 2 to £ ©

Figure 3-1

There are four sections:

® Section 1: Encode setup bar

® Section 2: System menu

® Section 3: Window function option bar
® Section 4: Window adjust bar

3.1 Encode Setup

Note: Some series don’t support sub stream 2.
The encode setup interface is shown as in Figure 3-2.

Sub Stream 1 Sub Stream 2 Eeddtdesd m

Figure 3-2

Please refer to the following sheet for detailed information.
10
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Parameter

Function

Main stream

Click it to enable main stream video monitoring and click again
to disable it. Generally for storage and monitor.

Sub Stream 1

Click it to enable Sub Streaml video monitoring and click again
to disable it. When network bandwidth is insufficient, it
substitutes main stream for monitoring.

Sub Stream 2

Click it to enable Sub Stream 2 video monitoring and click again
to disable it. When network bandwidth is insufficient, it
substitutes main stream for monitoring.

Protocol

You can select stream media protocol from the dropdown list.
There are three options: TCP/UDP/Multicast

3.2 System Menu

System menu is shown as in Figure 3-3.

Please refer to chapter 2 Live, chapter 3 PTZ, chapter 4 Playback, chapter 5 Setup, chapter 6 Alarm,

chapter 7 Log out for detailed information.

r Live T PTZ Flalbank T S:Etua T Alarm Luﬁnut ]

Figure 3-3

3.3 Video Window Function Option

The interface is shown as below. See Figure 3-4.

Please refer to the following

Figure 3-4

sheet for detailed information.

SN Parameter Function

1 Relay-out

It shows if there is any alarm output, status description is as
follows:

® Red: means there is alarm output.

® Grey: means alarm is over.

Click on the button to force alarm to be on or off.

11
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2 Digital ® When the video is in the original status, click it you can
Zoom select any zone to zoom in. In the non-original status,
you can drag the zoom-in zone in specified range. Right
click mouse to restore previous status.
® Click it; you can use the middle button of the mouse to
zoom in/out the video size.
3 Snapshot Click on the button to snapshot, save picture to path in Ch
5.1.2.5.
4 Triple Click it to take snapshot upon the video at the frequency of
Snapshot one picture per second. All images are saved to path in Ch
5.1.2.5.
5 Record Click it to record the video. All videos are saved to path in
Chapter 5.1.2.5.
6 Easy focus | Click it, you can see there are two parameters on the preview
video: AF Peak and AF Max.
AF Peak: It is to display the video definition during the focus
process.
AF Max: It is the most suitable value for the video definition.
The close the AF Peak and AF Max is, the better the focus
effect is.
7 Audio Turn on or off audio when you are monitoring.
8 Talk Click it to start or end bidirectional talk.
9 Help Click it to open help file.

3.4 Video Window Setup

The interface is shown as in Figure 3-5.

7 —
& 100% 53 o it O

ONONONONORONONO)

Figure 3-5

3.4.1 Image Adjustment
See Figure 3-6 for image adjustment.

12
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Image Adjustment

Figure 3-6

Click this button to display/hide image control interface. Click it to open picture setup interface. This
interface is on the top right pane.
Please refer to the following sheet for detailed information.

Parameter Function

Video It is to adjust monitor video Note:

setup brightness. ® All the operations here apply
to WEB end only.

® Please go to Setup-
>Camera->Conditions to

a It is to adjust monitor video adjust corresponding items.
hue.

m It is to adjust monitor video
contrastness.

E It is to adjust monitor video
saturation.

Reset | Restore brightness,
contrastness saturation and
hue to system default setup.

3.4.2 Original Size
Click this button to go to original size. It is to display the actual size of the video stream. It depends on
the resolution of the bit stream.

3.4.3 Full Screen
Click it to go to full-screen mode. Double click the mouse or click the Esc button to exit the full screen.

13
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3.4.4 Width and Height Ratio
Click it to restore original ratio or suitable window.

3.4.5 Fluency Adjustment

There are three levels of fluency for you to select (Realtime, Normal, and Fluency). The default is
normal.

3.4.6 Rules Info

Click the button, preview image will display intelligent rules after enabling; it is “enable” by default.
3.4.7 Zoom and Focus
Click this button and the focus zooming interface appears on the right of preview interface, as shown in
Figure 2-7, click left mouse button to adjust focus zooming configuration.

Note:

» The product series which support motorized zoom, synchronous focus and back focus have this

button.

» Auto-focus after zoom and focus adjustment.

3.4.8 Fisheye/Trigger Track

Click the button, installation mode and display mode interface will show up on the right of the preview
interface, see Figure 3-7 and Figure 3-8, and single click to switch different installation modes and
display modes for fisheye, or switch different display modes for trigger track, it is enabled by default.
Note:

It is only supported by some models.

Zoom and Focus

Focus Speed Pl

=-8
Near

7} Auto Focus

Restore All

Regional Focus

Figure 3-7
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Parameter | Function
Zoom Adjust the focal length of the lens by clicking or long pressing “+”“-’buttons.
The speed is used to adjust the length of one step during single click.
Focus Adjust the sharpness of the lens by clicking or long pressing“+”. “-” buttons.
Step length is used to adjust the length of one step with one click.
Click to adjust the image definition automatically.
Auto- )
Note:
focus
Other lens operations are not allowed during the process of auto-focus.
Reset the lens to zero position to eliminate the accumulative error of lens.
Reset All | NO® _ _ ) _
Please reset when the image adjustment is not clear or operating zoom focus many
times.
Refresh Synchronize the location of drag slider of lens and zoom focus after hardware zoom
focusing.
Regional | Click it and use the mouse to select a zone, then the device can auto focus within the
Focus specific region.

o

In-ceiling Mount Wall Mount

Installation Mode

Vo /.
oL Fl | é

Installation Mode

#a #a

Display Mode

Figure 3-8

Ground Mount

Installation Mode

0

. -p?

Display Mode
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parameter

Note

Installation Mode

Three modes which are ceiling mount, wall mount and ground mount.

Display Mode

It represents the display mode of the current image (default supports original
image mode), the display modes may be different according to different
installation modes. It is shown as follows:

e Ceiling: 1P+1, 2P, 1+2, 1+3, 1+4, 1P+6. 1+8.

e Wall: 1P, 1P+3. 1P+4. 1P+8.

e Ground: 1P+1. 2P. 1+3. 1+4. 1P+6. 1+8,

Note:

The default displays original image mode when switching installation mode.

In-ceiling/Wall/Ground

O

image

Original It menas the original image without de-warpping

In-ceiling/Ground

360°expanded rectangular panorama + independent
sub image, the sub image and the subbox in the
expanded rectangular panorama support zoom and
movement, for the expanded rectangular panorama
also supports left and right starting point movement.

—1p+1

Two related 180° expanded rectangular pictures, two
subwindows form 360° panorama anytime, which is
also called “dual panorama”. Two expanded
op rectangular pictures both support left and right
movement starting point, which are also linked by
eachother.

i

Original image + 2 independent sub images, both the
H—‘ sub image and the subbox in the original image
Q

(3]
|

support zoom and movement. The original image also
1+2 supports changing starting point by rotation (no such
display mode for ground installation).

Original image + 2 independent sub images, both the
sub image and the subbox in the original image
143 support zoom and movement. The original image also
supports changing starting point by rotation

3]

Original image + 4 independent sub images, both the
= sub image and the subbox in the original image

1+4 support zoom and movement. The original image also
supports changing starting point by rotation

360°expanded rectangular panorama +6 independent
sub image, both the sub image and the subbox in the
expanded rectangular panorama support zoom and
movement, for the expanded rectangular panorama
also supports left and right starting point movement.

—1P+6

16
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parameter Note
Original image + 8 independent sub images, both the
Q sub image and the subbox in the original image
I support zoom and movement. The original image also

supports changing starting point by rotation

Dol

1P

From left to right 180° expanded rectangular
panorama, which supports up and down movement
and changes vertical angle of view.

X

1P+3

180° expanded rectangular panorama+3 independent
sub images, both the sub images and the sub box in
the expanded rectangular panorama support zoom
and movement, expanded rectangular panorama
supports up and down movement and changes vertical
angle of view.

Wall

&
|

1P+4

180° expanded rectangular panorama+4 independent
sub images, both the sub images and the sub box in
the expanded rectangular panorama support zoom
and movement, expanded rectangular panorama
supports up and down movement and changes vertical
angle of view.

i

1P+8

180° expanded rectangular panorama+8 independent
sub images, both the sub images and the sub box in
the expanded rectangular panorama support zoom
and movement, expanded rectangular panorama
supports up and down movement and changes vertical
angle of view.

Display Mode

Al W5
.._‘...II'

Figure 3-9

Enable the trigger track on the interface of tripwire or intrusion, and draw the rule of tripwire or intrusion,
the scene of trigger track window will change according to the moving object when it triggers rule alarm
until the moving object disappears from the view range of the camera. Please refer to “5.3.4 IVS” for
more details about the rules drawing and parameter config of tripwire and intrusion.

Trigger track includes three modes which are 1P, 1P+3 and 1P+5.

[ E 1P: Original picture

17
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o . 1P+3: Original picture and three trigger track windows, it can adjust the location and size of

three trigger track windows on the original picture.

e || [ |1P+5: Original picture and five trigger track windows, it can adjust the location and size of

five trigger track windows on the original picture.

18
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4 PTZ Control

Here you can view direction keys, speed, zoom, focus, iris, preset, tour, scan, pattern, aux on, off and
PTZ setup button.

Note

Before PTZ operation, please make sure you have properly set PTZ protocol. (Please refer to Ch 5.5.3).
Currently only IPC-HFXXXX series and —PT series products can support PTZ function.

Parameter Note

L PTZ supports eight directions: left/right/up/down/upper left/upper right/bottom
PTZ direction left/bottom right.

It controls rotation speed. The longer the step length, the higher the speed.
Step length control PTZ, zoom, focus and iris.

Use mouse to draw a box in monitoring video, PTZ will rotate and focus to
Quick Position | uickly positioning.

@
000
060
000
speed(1-2): [ET
© 0
)
-0

PTZ Settings

oo ]

Speed

$o T

Figure 4-1
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000
0®o
00O

speed(1-2) [

© O

© O
© -0

PTZ Settings

Figure 4-2

PTZ setting interface is shown as in Figure 4-3.
Here you can set scan, preset, tour, pattern, assistant function and light and wiper plus view coordinate.

PTZ Settings

Figure 4-3

4.1 Scan

Scan interface is shown in Figure 4-4.

20
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PTZ Settings

Set Left Set Right

Figure 4-4

Steps to scan are:

Set Left Set Right

Step 1. Click on Set button, display icon.

Step 2. Move via direction key to select left, click on Set Left to set left border of camera
Step 3. Move via direction key to select right, click on Set Right to set right border of camera.
Step 4. Complete scan path setup.

4.2 Preset

Preset interface is shown in Figure 4-5.
PTZ Settings

Preset

Steps to preset are:

Step 1. In preset box, input preset value.

Step 2. Click on Go to, camera rotates to preset position.

Step 3. Use direction key to rotate camera, and in preset box input preset value.
Step 4. Click on Add to add a preset. Range of preset relates to PTZ protocol.

4.3 Tour
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Tour interface is shown in Figure 4-6.

PTZ Settings

P Start W Stop

Figure 4-6

Steps to tour are:

Step 1. In tour box, input tour path value.

Step 2. Click on Add. Range of tour relates to PTZ protocol.

Step 3. In preset box, input preset value.

Step 4. Click on Add as to add a preset in this tour. If click on Del, it deletes this preset in tour.
Note:

You can add more than one preset here, or delete more than one preset.

4.4 Pattern

Pattern interface is shown in Figure 4-7.

PTZ Settings

5
EZIETR

Figure 4-7

Steps to set pattern are shown as follows:
Step 1
Input pattern serial number value in the box, click “Add” and it will display “Start Rec” and “Stop Rec”.
Step 2
Click “Start Rec” to implement a series of operations such as zoom, focus, iris, direction and so on.
Step 3
22
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Click “Stop Rec” to complete the setting of a pattern path.
Step 4
Click “Start” and it will start pattern according to the pattern path which has been set; click “Stop” and

the pattern ends.

4.5 Assistant

Assistant interface is shown in Figure 4-8.

PTZ Settings

Assistant

Aux On Alx Off

Figure 4-8

Steps to assistant are:

Step 1. In assistant box input assistant value.

Step 2. Click on Aux On to turn on aux function.
Click on Aux off to turn off aux function.

4.6 Light/Wiper
Light wiper interface is shown in Figure 4-9.

PTZ Settings

Light Wiper -

Enable Disable

Figure 4-9

Steps to light wiper are:
® Click on Enable to enable light wiper function.
® Click on Disable to disable light wiper function.

23
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5 Playback

Web client playback supports video playback and picture playback.
Note:
e Before playback, user shall set storage management as in Ch. 5.4,
e If you use Dahua SD card, make sure it is authenticated first.

5.1 Playback

The playback interface is shown as in Figure 5-1.

SR SD Card [~

e < BT

Sun Mon Tue Wed Thu Fri Sat
1
213456 7]8

9 10 11 12 13 14 15

1617 18 19 20 21 22 EEE
2324125126 |27 28| 29

a0 [31]

-
1 00000 O CIEEEETTEID

' 4
Stop Record Type M Al [ General m [ Moton M [ Alam Manual B [CETH ICI

Figure 5-1

There are four sections:

® Section 1: Function of play
® Section 2: Playback file

® Section 3: Play time cut

® Section 4: Record type

® Section 5: Progress bar
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® Section 6: Assistant function

5.1.1 Function of Play
The function of play is shown as in Figure 5-2 and Figure 5-3.

00000 O =0

O @ 6@ @ 6 ® @ @-1

Figure 5-2

00000 O =0

© e 6 e 6 ® O &2

Figure 5-3
Parameter Function
@ Pla When you see this button, it means pause or not played record. Click on this
y button, switch to normal play status.

@ Stop Click this button to stop playing.

Click on this button to go to next frame.
@ Play by frame Note:

You shall pause record when you use this function.
@ Slow Click on this button to play slowly.
® Quick Click on this button to play quickly.
® Silent When this button displays, it means audio is silent. Click on this button to

switch back to normal.
@ Volume Click on left mouse to adjust volume.
-1 Fisheve Click this button and fisheye device can adjust display mode according to
y different installation mode during the process of playback.
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Parameter Function

Click the button and it will playback and display intelligent rules and object
-2 Rule Info detection box if the video is equipped with intelligent rule info after the
function is enabled, it is off by default.

5.1.2 Playback File
In calendar, blue date represents data currently has video record or snapshot. See Figure 5-4.

< 2013 I8

Sun Mon Tue Wed Thu Fri Sat

3 4 5

Figure 5-4
Parameter Function
) e Select “dav”, as video playback.
File Type - )
e Select “jpg” as picture playback.
Data Source Default is SD card.

Step 1. Click on data in blue, time axis displays record file progress bar in color. While, green represents
normal record, yellow represents motion detect record, red represents alarm record, and blue

represents manual record.
Step 2. Click on certain time on progress bar, playback starts from this time. See Figure 5-5.

Figure 5-5
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Step 3. Click on file list = , Select date file will be displayed in list.

Step 4. Double click on file in list, playback this file and display file size, start time and end time.

See Figure 5-6.

00:00:00-23:589:59

General, Event, Alarm, Manual

Download Format @ dav © mp4

Start Time  File Type
154939 H ©
15:50:07
15:54:38
16:25:13
16:31:35
16:32:06
16:45:58
16:54:00

(el e NeleNeleNe

17:00:54

<171 » »i (IO
Begin Time:
End Time:

File Size:

Figure 5-6
Parameter Function
BSearch It means records within searched start time and end time on the date.
Download .
Format There are two formats: dav, mp4.
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Parameter Function

m ® click the download button and download file to path in Ch. 5.1.2.5.
Download ® System does not support download and playback at the same time.

rs

Back Click on back button to go to calendar interface.

5.1.3 Playback Cut

Note:

Playback cut function will automatically pause playing record as playback cut and playback cannot be at
the same time.

Step 1. Click on start time to cut on time axis. This time must be within progress bar range.

—_—

Step 2. Move mouse to cut icon gﬁ . You will be ask to select start time. Click on cur icon 5‘5 as

finish cutting.

Step 3. Click on playback cut end time on time axis. This time must be within progress bar range.
— —

Step 4. Move mouse to cut icon-& you will be asked to select end time. Click on cut icon .& as
finish cutting.
Step 5. Click on Save button to save file cut to path in Ch 5.1.2.5. See Figure 5-7.

00:00:00-00:00:00 B

Figure 5-7

5.1.4 Record Type
After checking record file type, only selected file will be displayed in progress bar and file list. Users can

also select the record type to be displayed via the dropdown box which is above the file list. See Figure
5-8.

Record Type [ Al [ General [ Motion @ & Alarm & Manual W

Figure 5-8

5.1.5 Progress Bar
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@zhr | O4nr | ©30min

Figure 5-9

Parameter Function

(O z4hr 24 hours Click on it, means video in past 24 hours.

©zhr |, hours Click on it, means video in past 2 hours.
Oinr |, hour Click on it, means video in past 1 hour.
®:z0min 30 min Click on it, means video in past 30 min.

5.1.6 Assistant Function
Video playback assistant function is shown in Figure 5-10.

Figure 5-10

Parameter Function

Digital Zoom restore its original size.

e Click on it, video in playback status if is in original size, user can
zoom in any area, If it is not in its original size, Right mouse click to

e Click on this button, you can scroll to zoom in.

Snapshot will be saved to path in Ch. 5.1.2.5.

E] Click on this button, you can snapshot video under playback status.
Snapshot

5.2 Picture Playback

Web client picture playback interface has the following three functions:

Parameter Function

1 Play function bar
2 Playback file bar
3 Snapshot type bar
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See Figure 5-11.

@Jhua

File Type [0 [~

Data Src _SD Card E]
e < T

Sun Mon Tue Wed Thu Fri Sat
112|345 6]7

1M11213 14

18 |19 20/ [21]

251262728

[>)

Snapshot Type All General W Event B Alarm

Figure 5-11

5.2.1 Play

oo

Figure 5-12

Default icon is E and it means pause or not played picture. Click on play button to switch to

normal play status. lcon become m

Click on it to pause.
5.2.2 Playback File
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< 2013 S

Sun Mon Tue Wed Thu Fri Sat

Figure 5-13

Step 1. Click on file list = select snapshot file of the date.

Step 2. Double click on file in list, to play this snapshot.

Parameter

Function

n Search

It means all snapshot files within the start time and end time of selected date.
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Parameter Function
m Click the download button to open snapshot file or directly download to local
Download according to the browser types.

& Back Click the back button to return to calendar interface and re-select time.

00 : 00 : 00 - 23 : 59 : 59 |fe}

Start Time  File Type
13:23:16 O
13:24:55
13:25:09
13:25119
13:25:29
13:25:40
13:25:50
13:26:09
13:26:19
13:27:41
13:27:51
13:28:01

=
O

&
I (cleReNeNeNelelleRe e

B

M <€1/1p P

Figure 5-14
5.2.3 Snapshot Type
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After checking snapshot file type, in file list only display file of selected type. Users can also select the
snapshot type to be displayed via the dropdown box above the file list. See Figure 5-15.

Snapshot Type All General Event W Alarm

Figure 5-15
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6 Setup

Web client setup support camera, network, time, storage, system and system info view.

6.1 Camera

The camera setting includes conditions, profile management, zoom and focus.

6.1.1 Conditions

Note:

The camera parameter may be different according to different models, please refer to the actual product

for more details.

6.1.1.1 Picture

Note:

The device which supports true WDR fails to support long exposure when true WDR is enabled.

Step 1

Select “Setup > Camera > Conditions > Picture” and the system will display the “Picture” image which is

shown in Figure 6-1.
E)TE]

- TECHNOLOGY

Conditions Profile Management§ Zoom and Focus

Profile: Day
> Video

> Audio A Style ' Standard E
Network = SLAES 2 S » Exposure Brightness [=] 50
Event ~ : — bBacklignt Contrast (=] 50
Storage R N e Saturation (=]

System » Day & Night
Information K » IR Light

Sharpness [=]

() (=) () (=) ()
[
a

Gamma (=]

Mirror ©) ON @ OFF

Flip | 0° |z|

Default | | Refresh | i Save

Figure 6-1
Step 2
Set picture parameters; please refer to the following sheet for more details about parameter setting.
Parameter Note
Style It is to set the picture style, which includes standard, soft and vivid.
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Parameter

Note

Brightness

It is to adjust the image overall brightness via linear adjustment mode.
The larger the number is, the brighter the picture is, and on the contrary it
is opposite. The picture get blurry easily when the value is set too big.

Contrast

It is to adjust the picture contrast. The bigger the value is, the bigger the
bright contrast becomes, and on the contrary it is smaller. The dark area
becomes darker and the bright area becomes overexposed easily when
the value is set too big. The picture becomes blurry when the value is set
too small.

Saturation

It is to adjust the color darkness and lightness. The color becomes darker
when the value is bigger; on the contrary it becomes lighter. The value
causes no influence to the overall brightness of the image.

Sharpness

It is to adjust the sharpness level of the picture edge. The bigger the
sharpness value is, the more obvious the image edge becomes, the image
is likely to generate noise more easily when the value is set too big.

Gamma

It is to change image brightness and improve the dynamic display range of
the image via nonlinear adjustment mode. The bigger the value is, the
brighter the picture becomes, and on the contrary it is opposite.

Mirror

After mirror is enabled, the monitoring image will be displayed invertedly.

Flip

It is to change the display direction of the monitoring image.
It includes following options:
e Normal: The monitoring picture is normally displayed.

e Flip mode 1: The monitoring picture is displayed with clockwise
rotation 90°

e Flip mode 2: The monitoring picture is displayed with anticlockwise
rotation 90°

e 180°: The monitoring picture is displayed upside down.
Note:

Please set the video resolution as 1080P or lower when applying flip mode
for some devices.

EIS

It can realize electronic anti-flicker function via comparison algorithm of
image difference, which can effectively solve the problem of image jittering
during application and it can make the image clearer.

Step 3

Click “Save” and complete the image parameter config of the camera.
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Select “Setup > Camera > Conditions > Exposure”. The system will display the “Exposure” interface

which is shown in Figure 6-2.

> Video

> Audio
Network
Event
Storage
System

Information

Profile Normal

» Picture

Anti-flicker | Outdoor

!
[=]
P | Mode| Aut B

» Backlight

Autolris @ ON () OFF
» WB ~
3DNR® ON () OFF

» Day & Night
ol Grade (=] 0 50

» IR Light

Figure 6-2
Step 2
It is to set the exposure parameter, please refer to the following sheet for more details.
Parameter Note
® You can switch to exposure mode when it is in outdoor
mode, it can realize the result in the corresponding exposure
mode.
® 50Hz: When the current is 50Hz, system can auto adjust the
Anti-flicker

exposure according to the environment brightness in case
there is any stripe.

® 60Hz: When the current is 60Hz, system can auto adjust the

exposure according to the environment brightness in case
there is any stripe.
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Parameter Note
It is the camera exposure mode.
Note:
® When “Anti-flicker” is “Outdor”, the “exposure mode” can be
set as “gain priority” or “shutter priority” mode.
® Different devices have different exposure modes; please
refer to the actual interface.
It includes the following options:
® Auto: It can auto adjust the image brightness according to
the environment.
® Gain priority: The device can auto adjust according to the
gain range which is set by priority during normal exposure
range according to the different scene brightness. The device
will auto adjust shutter value if the image brightness fails to
reach the effect and the gain value has reached to upper limit
Mode or lower limit, which is to make the image reach the best
brightness.
® Shutter priority: The device can auto adjust according to the
shutter range which is set by priority during normal exposure
range according to the different scene brightness. The device
will auto adjust shutter value if the image brightness fails to
reach the effect and the shutter value has reached to upper
limit or lower limit, which is to make the image reach the best
brightness.
® Iris priority: Iris value is fixed, the device can auto adjust the
shutter value if the image brightness fails to reach effect and
the shutter value has reached the upper limit or lower limit,
the device can auto adjust the gain value to make the image
reach the best brightness.
® Manual: It is to manually set gain value and shutter value,
adjust the the displayed brightness of the image.
It can set the parameter when the camera installs auto iris.
® The lens iris can auto adjust the size according to the
environment after auto iris is enabled, then the image
Auto Iris brightness will change accordingly.
® The iris value reaches the max when disabling auto iris, the
lens iris will not change according to the environment
brightness.
It is to process the image with multiframe (at least two frames), it
3D NR can realize noise reduction of the image by using the interframe
information between the previous and latter frame.
Grad It can set the parameter when “3D NR” is enabled.
rade
The bigger the grade is, the better NR effect it can realize.
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Step 3

Click “Save” to complete the parameter config of camera exposure.

6.1.1.3 Backlight

Backlight mode can be divided into BLC, WDR and HLS.

BLC: it can avoid cucoloris phenomenon of the darker area in the backlight environment.

WDR: It can suppress the overbright area and compensate darker area by enabling WDR, which can
make the overall image clear.

HLC: It is to weaken the high light, which can be applied in the areas such as toll gate, entrance and exit
of the parking lot and etc. As for extreme light, it can snapshot the human face in the dark environment
and it can realize better effect for the details of the plate number.

Step 1
Select “Setup > Camera > Condition > Backlight”, the system will display the interface of “Backlight”
which is shown in Figure 6-3.

Profile Normal

> Audio S ' (ARELE Mode | OFF [+]
Network e S - = = & » Exposure
storage g : -

System o » Day & Night
. -
Information 4 » IR Light

| Default ‘ l Refresh | | Save I

Figure 6-3

Step 2

Set the backlight parameter.

® \When the “Mode” is set as “Scene Self-adaptation”, the system will auto adjust the image
brightness according to the environmental brightness, which is to make the object display clearly in
the scene.

® When the “Mode” is set as “BLC”, it can select default mode or customized mode.

€ When selecting “Default” mode, the system can realize auto exposure according to the
environment, which is to make the image in the darkest area clear to be seen.
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€ When selecting “Customized” mode, the system can realize exposure upon the selected area
after it set customized area, which is to make the image of the selected area reach
appropriate brightness.
® When the “Mode” is set as “WDR”, it will lower the brightness of the area with high brightness and
enhance the brightness of the area with low brightness, which is to make the objects in both high
brightness and low brightness area display clearly.
Note:
There may be video loss of a few seconds when the camera is switched from non WDR mode to WDR
mode.
® When the “Mode” is set as “HLC”, the system will constrain the brightness of the area with high
brightness and decrease the size of the halo area, which is to lower the brightness of the whole
image.
Step 3
Click “Save” to complete the config of the backlight mode.

6.1.1.4 WB

WB is used to restore the white object in the scene by the camera, after WB mode is set, it can make
the white object look white in different environments.

Step 1

Select “Setup > Camera > Conditions > WB”, the system will display the interface of “WB”, which is
shown in Figure 6-4.

Profile Normal
> Video

> Audio h "y".;' bids Mode | Auto E
Network = =25 ? — » Exposure
Event : B » Backlight

System » Day & Night

Information » IR Light

| Default | | Refresh ] \ Save ‘

Figure 6-4

Step 2
Set WB mode.
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® \When the “Mode” is set as “Auto”, the system can auto compensate white balance upon different
color temperatures, which is to make the image color normal.

® When the “Mode” is set as “Natural”, the system can auto compensate white balance to the scene
without artificial light, which is to make the image color normal.

® When the “Mode” is set as “Street Lamp”, the system can auto compensate white balance to the
outdoor scene at night, which is to make the image color normal.

® \When the “Mode” is set as “Outdoor”, the system can auto compensate white balance to the most
outdoor scenes with natural light and artificial light, which is to make the image color normal.

® \When the “Mode” is set as “Manual”, it can manually set the value of red gain and blue gain; the
system can compensate the different color temperatures in the environment according to the
settings.

® When the “Mode” is set as “Regional Custom”, it is to set customized area, the system can
compensate white balance to different color temperature of the images in the area, which is to
make the image color normal.

Step 3
Click “Save” to complete the config of WB mode.

6.1.1.5 Day & Night

It is to set the switch between color mode and black & white mode.

Step 1

Select “Setup > Camera > Conditions > Day & Night” and the system will display the interface of “Day &
Night”, which is shown in Figure 6-5.

- Profile Normal
> Video

> Audio ’ k R Mode | Auto

[=]

e E— . [=]

Network S e — DAEIEEE Sensitivity | Middle [+]
[+]

— %% X
Event 2HackichE Delay|6S

- .
Storage BN > WwB

» Day & Night

System

Information » IR Light

| Default | | Refresh | | Save I

Figure 6-5
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Set day & night parameter; please refer to the following sheet for more details.

Parameter

Note

Mode

It is to set the camera image displayed as color or black & white mode.

Note:

The setting of “Day/Night Mode” is not affected by the setting of “Profile

Management”.

It includes the following options:

® Color: The camera image is displayed as color image.

® Auto: The camera can auto select color image or black & white image
to be displayed according to the environmental brightness.

® Black & white: The camera image is displayed as black & white image.

Sensitivity

The parameter can be set when the “Day/Night Mode” is “Auto”.
It is to set the sensitivity of the switch between image color display and
black & white display.

Delay

The parameter can be set when the “Day/Night Mode” is “Auto”.
It is to set the switch delay between image color display and white & black
display. The smaller the delay is, the faster of the switch becomes between

color display and black & white display.

Step 3

Click “Save” to complete the config of day/night mode.

6.1.1.6 Defog

The image quality will become weak when the device is in the environment with fog or haze, you can
enable defog function to adjust the image definition.

Step 1

Select “Setup > Camera > Conditions > Defog” and the system will display the interface of “Defog”
which is shown in Figure 6-6.
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S— Profile Day
> Video g

> Audio . | Piowre Mode OFF [~]
Network & 5 % 5 - » Exposure

Event - » Backlight

Storage 5 ] » WB

System » Day & Night

Figure 6-6

Step 2

It is to set defog mode according to the actual scene.

® \When the “Mode” is set as “Manual’, it is to manually set intensity and air light mode, the system
will adjust the image definition according to the intensity and air light mode which have been set
previously. As for air light mode, you can set manual or auto.

® \When the “Mode” is set as “Auto”, the system will auto adjust the image definition according to the
actual scene.

® When the “Mode” is set as “Off”, then the defog function is disabled.

Step 3
Click “Save” to complete the config of defog mode.

6.1.1.7 IR Light

You can directly set the mode of IR light if the device is equipped with IR light.

Step 1

Select “Setup > Camera > Conditions > IR Light” and the system will display the interface of “IR Light”
which is shown in Figure 6-7.
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> Video
> Audio
Network
Event
Storage

System

Step 2
Itis to set

Information - » IR Light
. Do >~
. -
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Profile Normal

Pictt
» Picture Mode | SmartiR [+]
» Exposure
» Backlight
» WB

» Day & Night

[ oeaut |[  Refesn |[  saw |

Figure 6-7

IR light mode according to the actual scene.

® When the “Mode” is set as “Manual’, it can manually set the brightness of IR light; the system will
realize light compensation to the image according to the IR light intensity.

® When the “Mode” is set as “Smart IR”, the system can adjust the light brightness according to the
actual scene.

® \When the “Mode” is set as “Zoomprio”, the system can auto adjust the IR light according to the
brightness change of the actual scene.

L 4

L 4
® \When
Step 3

The system will enable near light by priority when the actual scene becomes dark, the system
will enable the far light when the near light fails to meet the requirement of scene brightness
even if it is adjusted to the brightest.

The system will adjust far light brightness by priority to off and then adjust the brightness of
near light when the actual scene becomes bright. The system will always disable far light
when the focal length of the lens is adjusted to a certain wide angle, which is to avoid near

overexposure. Meanwhile, it can manually set light compensation to slightly adjust the
brightness of IR light.

the “mode” is set as “Off”, it will not enable the IR light.

Click “Save” and complete the config of IR light.
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6.1.1.8 Profile Management

Step 1

Select “Setup > Camera > Conditions > Profile Management” and the system will display the interface of

“Profile Management”.

Step 2

Set profile management.

® When the “Profile Management” is set as “Normal”, the system will monitor according to the normal
config.

@hua (I SN e TN SN ST

Camera Conditions Profile Management Zoom and Focus @
“enaiions

Profile Management & Normal ¢ Full Time ¢ Schedule

> Video

> Audio Default | | Refresh | |
Network

Event
Storage
System

Information

Figure 6-8

® \When the “Profile Management” is set as “Full Time”, you can select “Always Enable” in “Day” or
“Night’, the system will monitor according to the config of “always enable”.

@hua

Camera Conditions Profile Management] Zoom and Focus

i Profile Management ¢ Normal  Full Time ¢ Schedule

Always Enable Day ":]

> Video

> Audio

Network | Default [ | Refresh I |

Event
Storage
System
Information

Figure 6-9

® \When the “Profile Management” is set as “Schedule”, you can set some period as day and another
period as night, for example, if it sets 0:00~12:00 as day, 12:00~24:00 as night, then the system will
monitor by adopting corresponding config in different periods.
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AT SN T AT YN T
®

Conditions Profile Management Zoom and Focus

Profile Management ¢ Normal € Full Time { Schedule
> Video

> Audio

Netnr peroaseting (] e et et e e et e e e
Event 0:00 4:00 8:00 12:00 16:00 20:00 24:00
Storage E Day M Night

system [ petaut ][ Reiesh ][ _ sae |

Information

Figure 6-10
Step 3
Click “Save” to complete the settings of profile management.
Note:

Click “Default” to restore the device to default config; click “Refresh” to check the latest config file of the
device.

6.1.1.9 Zoom and Focus

Note:

Only motorized vari-focal devices support focus and zoom function.

Step 1

Select “Setup > Camera > Conditions > Zoom and Focus” and the system will display the interface of
“Zoom and Focus” which is shown in Figure 6-11.

@hua [ wve | rm | papscc | sewp | sm_ | ogouw ]
®

Camera Conditions

Profile Management Zoom and Focus

> Video

> Audio
Network
Event
Storage
System
Information

s
zoom WDE (=) (O TELE Speed [20 » Restore All
Focus NEAR (=) (0 FAR  Speed [20 =] | D+JAutoFocus Refresh

Figure 6-11

Step 2
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Adjust the focal length of the lens.

After it is zoomed, set “Speed” and press “+”, “-“or drag the sliding block directly to adjust.

Step 3

Adjust the lens definition.

After it is focused, set “Speed” and press “+”, “-“or drag the sliding block directly to adjust.

Note:

® Speed is used to set the length by pressing “+” and “-“.

® After adjusting the focal length of the lens or click “Auto Focus”, the device will auto adjust the
image definition, it is not allowed to implement other lens operation during auto focus.

® After several times of zoom and focus, the image fails to be adjusted clear, click “Restore All’ to
reset the lens to zero and remove the accumulative error of the lens.

® Click “Refresh” and the device will automatically synchronize the hardware to the location of sliding
block of lens zoom and focus.

6.1.2 Video

6.1.2.1 Video

Step 1

Select “Setup > Camera > Video > Video” and the system will display the interface of “Video” which is
shown in Figure 6-12 (Non fisheye) or Figure 6-13 (Fisheye).

aJhua

- TECHNOLOGY

Camera Video Snapshot Overlay

> Conditions

Network Enable Sub Stream 2 v
Event Encode Mode H.264H v Encode Mode H 264H v
Storage Smart Codec OFF v * Resolution D1 (704*480) v
System Resolution 2304x1296 (230471296 ¥ Video Clip
TR S Frame rate(FPS) 30 v Framerate(FPS) |6 v
Bit Rate Type CBR v Bit Rate Type CBR v
Reference Bit Rate  1792-10240Kb/S Reference Bit Rate  48-886Kb/S
Bit Rate 6144 v Bit Rate 896 v
| Frame Interval 60 (30~150) | Frame Interval 12 (6~150)

#| Watermark Settings

Watermark Character | Digital CCTV

Default || Refresh Save

Figure 6-12 (Non fisheye)
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Snapshot

2-CONHons Installation Mode Ceiling |z|
m Record Mode 2P EI
> Audio
Network Main Stream Sub Stream
Event [v] Enable Sub Stream 1 [~]
Storage Code-Stream Type | General E‘ Code-Stream Type  General El
System Encode Mode H.264 =l Encode Mode H.264 [~]
oEEon Resolution 2432x2432 (2432°2432) [+ ] Resolution 640x640 (640°640)  [~]
Frame rate(FPS) 15 Izl Frame rate(FPS) 15 El
BitRate Type CBR =] Bit Rate Type CBR [~]
Reference BitRate  2048-11008Kb/S Reference BitRate  256-1792Kb/S
BitRate 8192 [+] HEREE 1024 [=]
| Frame Interval 30 (15~150) | Frame Interval 30 (15~150)
sve 1(off) [~] 2ve 1(off) [=]
[v] Watermark Settings
Watermark Character | Digital CCTV
Default I | Refresh | | Save

Figure 6-13 (Fisheye)

Step 2
Set video bit stream, please refer to the following sheet for more details about the parameters.

Parameter Function

It will display the parameter when the device is fisheye.
There are three installation modes for fisheye which are
ceiling, wall mount and ground installation, please
select installation mode according to the actual
installation scene of the fisheye.

The system will begin to switch after switching
installation mode, it will prompt successfully saved after
it is switched successfully.

Note:

The device end will output the dewarped video stream
after configuring installation and record mode, when the
device is accessed to third-party platform, it will directly
display the dewarped image on the third-party platform.

Installation Mode
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Parameter

Function

Record Mode

It will display the parameter when the device is fisheye.

The system will begin to switch after record mode is

switched, it will prompt saved successfully after it is

switched successfully.

The record mode will change according to the different

installation modes.

® 10: the original picture which is not dewarped.

® 1P: 360°rectangular panorama.

® 2P: The mode can be set when the “Installation
Mode” is set as “Ceiling” or “Ground”. It is the 2
related 180°rectangular image, the two sub
windows can both form 360°panorama anytime.

® 10+3R: original image + 3 independent sub
images, both the sub image and sub boxes in the
original image can support zoom and movement.

® 1R: Original image + independent sub image, the
sub boxes of the original image support zoom and
movement.

® 4R: original image + 4 independent sub images,
both the sub image and sub boxes in the original
image support zoom and movement.

® 2R: Original image + 2 independent sub images,
the sub boxes of the original image can support
zoom and movement, the sub image supports up
and down movement, which can change the
vertical angle of view.

Note:

The device end will output dewarped video stream after

configuring installation and record mode, when the

device is accessed to the third-party platform, it will

directly display the dewarped image on the third-party

platform.

Sub Stream Enable

Select “Enable” to enable sub stream.
The device supports enabling sub stream 1 and sub
stream 2 at the same time.

Smart Codec

It can enhance image compression performance and
reduce storage space by enabling intelligent encoding.
Note:

After intelligent encoding is enabled, the device will not
support third stream, ROI or intelligent event detection,
please refer to the actual interface for more details.
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Parameter

Function

Encode mode

There are five options: H.264 (main profile standard,

H.264H (high profile standard), H.264B (Baseline

Profile), H.265 (main profile standard) and MIJPEG

encode.

® The H.264, H.264H both are H264 bit stream.
H.264 is the Main Profile encode and you need to
enable the sub stream function in your camera and
set the resolution as CIF. Then you can monitor via
the Blackberry cell phone.

® The H.265 is the main profile encode mode.

® MJIPEG: In this encode mode, the video needs to
large bit stream to guarantee the video definition.
You can use the max bit stream value in the
recommend bit to get the better video output effect.

Resolution

There are multiple resolutions. You can select from the
dropdown list.

For each resolution, the recommended bit stream value
is different.

Note: When video is under rotating status, you cannot
set resolution higher than 1080P (excluding 1080P).

Video Clip

The function is only supported by sub stream 2, please
refer to “Video Clip” for more details below the sheet.

Frame Rate (FPS)

PAL: 1~25f/s, 1-50f/s NTSC: 1~30f/s or 1~60f/s.
The frame rate may vary due to different resolutions.

Bit Rate Type

There are two options: VBR and CBR.
Please note, you can set video quality in VBR mode.
Under MJPEG mode, only CBR is available.

Recommended Bit

Recommended bit rate value according to the resolution
and frame rate you have set.

® In CBR, the bit rate here is the max value. In

Bit Rate o
dynamic video, system needs to low frame rate or
video quality to guarantee the value.
® The value is null in VBR mode.
® Please refer to recommend bit rate for the detailed
information.
svC Frame rate can be encoded by layer. It is a flexible
encoding method. By default, itis 1 as 1 layer. You also
can set 2/3/4 layers.
| Frame Here you can set the P frame amount between two |

frames. The value ranges from 1 to 150. Default value
is 50.

Recommended value is frame rate *2.
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Parameter

Function

Watermark Settings

Select “Watermark Setting” and enable watermark
function. After the watermark function is enabled, you
can check if the video is tampered via verifying
watermark character.

Watermark Character

It is the character of watermark verification; it is Digital
CCTV by default.

® Video Clip

1. Select “Sub Stream 2” in the drop-down box, click “Enable”.

2. Enable “Video Clip”, click

X2

The system will display the interface of “Area”, which is shown in Figure 6-14.

Area

oo
-

—~ ‘»”-

Resolution :'701 (704%430) B Save Cancel

Figure 6-14

50



@Z@ya Dahua Network Camera Web 3.0 Operation Manual
3. Select the needed resolution and clip the needed image on the interface, which is shown in Figure
5-15.
4. Click “Save”. You can check the clipped video in the preview interface (the sub stream 2 preview
interface only displays the clipped area), which is shown in Figure 6-15.

@Jhua

BE =

$o TE

Figure 6-15

Step 3
Click “Save” to complete video stream setup.

6.1.2.2 Snapshot
The snapshot interface is shown as in Figure 6-16.

@Jhua

Video

Snapshot

> Conditions —
Snapshot Type |Genera| v |
Image Size 1080P (1920*1080)
> Audio ——
Quality |5 M
Network R
Interval 15 v
Event |7|
Storage | Default ‘ | Refresh | ‘ Save
System
Information
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Figure 6-16
Please refer to the following sheet for detailed information.
Parameter Function
Snapshot type There are two modes: general (schedule) and Event (activation).
Image size It is the same as the resolution of main stream.
Quality It is to set the image quality. There are six levels.
Interval It is to set snapshot frequency. Optionall~7s/picture, customized.

6.1.2.3 Video Overlay
The video overlay interface is shown as in Figure 6-17.

Camera Video Snapshot Overlay ROI Path

> Conditions
» Channel Title

> Audio

Network » Time Title

Event » Text Overlay

Storage

» Font Attribute
System

» Picture Overlay
Information

» Custom Overlay

Remove All Delete (Or Rightclick )

| Default l | Refresh I | Save I

Figure 6-17
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Camera

> Conditions

> Audio
Network

Event

Storage

System

Information

Camera

> Conditions

> Audio
Network
Event
Storage
System

Information
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Video

Snapshot

Overlay ROI

Default

Refiesn ||

Save l

Video

Snapshot

Figure 6-18

I Overlay I

Default

Save |

Figure 6-19

ROI

Path
» Privacy Masking @ Enable Disable
iputChamnel Tie
» Time Title IPC

» Text Overlay Text Align

» Font Attribute Right
» Picture Overlay

» Custom Overlay

| e

» Privacy Masking @ Enable Disable
» Channel Title || Week Display

» Text Overlay

» Font Attribute

» Picture Overlay

» Custom Overlay
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Camera video | smapsnot | overiay | ROI | Path _

> Conditions
» Privacy Masking @ Enable Disable
> Audio » Channel Title Input Text:
Network » Time Title hello
Event » Text Overlay
Storage » Font Attribute =
ABab12!
System » Picture Overlay
Information AABECCOD v
» Custom Overlay
Text Align
Right [~]

pefaut ][ Refresh ][ sae |

Figure 6-20
Camera viieo | snapsnot | overay | ROl | Path ]

> Conditions
» Privacy Masking Color -
> Audio » Channel Title Font Size
Network » Time Title Self-adaptation [~]

Event » Text Overlay

» Picture Overlay

Storage

System

Information » Custom Overlay

Defaut__[[ Reresh ][ saw |

Figure 6-21
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Camera Video I Snapshot I Overlay I ROI I Path _

> Conditions
» Privacy Masking Enable @ Disable
> Audio
Network
Event

» Channel Title Picture Preview:
» Time Title
» Text Overlay

Storage » Font Attribute

» Picture Overlay

» Custom Overlay

System

Information

Upload Picture

Requirement for picture upload
1. Max size is 16k.
2. Max resolution is 128x128 pixels.

3. 256 colors, bmp format.

Default ] ] Refresh I | Save |
Figure 6-22
Camera vieo | snapsnot | overay | RO | Path _

> Conditions
» Privacy Masking Enable @ Disable
> Audio
Network
Event

» Channel Title Enter Custom OSD
» Time Title r
» Text Overlay Text Align

» Font Attribute Right ‘Z]
» Picture Overlay

Storage

System

Information » Custom Overlay

Default | | Refresh J | Save |

Figure 6-23

Please refer to the following sheet for detailed information.

Parameter Function

Privacy Masking ) Herg you can privacy mask the specified video in the
monitor video.

® System max supports 4 privacy mask zones.

Time Title ° _You can.engble. this fqnction so that system overlays time
information in video window.

® You can use the mouse to drag the time tile position.

Channel Title ® Youcan 'enable this _fun_ction so that system overlays
channel information in video window.

® You can use the mouse to drag the channel tile position.

® Click the "+" sign to add a line for the title, and you can
have 2 lines at most for channel title.
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Text Overlay

® You can enable this function to overlay text in video
window.

® Private protocol is connected to mobile NVR, support GPS
information overlay.

® You can use the mouse to drag location box to adjust its
position. Alignment include align left and align right.

® Click the "+" sign to add a line for the text, and you can
have 14 lines at most for the text.

Font Attribute

You can change the size and color of the words in the overlay.

Picture Overlay

® You can enable this function to display overlay picture.
Click on disable to turn it off.

® Click on Upload Picture to overlay local picture into
monitoring window. You can drag the yellow box to move
it.

Note:

You cannot enable text and picture overlay at the same time.

Counting

® Check “Enable” to display the counting statistics data in
the video monitoring window; check “Disable” not to
display.

® There are enter number and leave number for statistics
type and left align and right align for OSD info.

Custom Overlay

® You can use the mouse to drag location box to adjust its
position. Alignment include align left and align right.

® Click the "+" sign to add a line for the title, and you can
have 2 lines at most for the title.

Refresh ® Set privacy mask, channel title, time title, location, overlay
and save the change. You can click on Refresh to see
effect.

Default ® Click it to restore default config.

Save ® Click it to complete video settings.

6.1.2.4 ROI

Note: Some series don’t support ROI setup function.
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Snapshot Path

Enable (e Disable

> Audio Image Quality |6(best) v

Network
S
Storage
System

Information

[ Remowean || Deete | orRighteiick)

| Default ' ! Refresh ‘ i Save

Figure 6-24
@hua

Camera Snapshot Overlay

> Conditions

> Audio

Enable (e Disable
Image Quality |6(best) v

Network
Event
Storage
System

Information

Remove All Delete (Or Rightclick )

| Default | l Refresh | i Save

Figure 6-25

Parameters | Note

Check “Enable”, then it will display the ROI in the video monitoring window;
Check “Disable”, then it won’t display.

Enable
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e Set the image quality of ROI, ranging from 1~6, default is 6.

Image Note:
Quality For fisheye device, it ranges from 1~6 (best), default is 6 (best)

e Able to set area block, max 4 areas.

6.1.2.5 Path

The storage path interface is shown as in Figure 6-26.

Here you can set snap image saved path and the record storage path.

® The default monitor image path is C:\Users\admin\WebDownload\LiveSnapshot.

® The default monitor record path is C:\Users\admin\WebDownload\LiveRecord.

® The default playback snapshot path is C:\Users\admin\WebDownload\PlaybackSnapshot.
The default playback download path is C:\Users\admin\WebDownload\PlaybackRecord.
The default playback cut path is: C:\Users\admin\WebDownload\VideoClips.

Note:

Admin is locally logged in PC account.

Please click the Save button to save current setup.

Video Snapshot

Live Snapshot C:\Users\admin\WebDownload\LiveSnapshot Browse...
s = Live Record C:\Users\admin\WebDownload\LiveRecord Browse...
> Audio
Playback Snapshot  C:\Users\admin\WebDownload\PlaybackSnapshot Browse...
Network
Event Playback Download = C:\Users\admin\WebDownload\PlaybackRecord Browse...
ven
Video Clips C:\Users\admin\WebDownload\VideoClips Browse...
Storage
System Default | I Save
Information

Figure 6-26
6.1.3 Audio
Please note some series devices do not support audio function.
6.1.3.1 Audio

The audio interface is shown as below. See Figure 6-27.
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@lhua

Camera Audio
> Conditions
> Video — Encode

. Audio Main Stream
Network [v] Enable
Event Encode Mode G.7T11A

Storage Sampling Frequency | 16k

System

i Sub Stream
Information

Encode Mode G.711A

[=]
[=]
[C] Enable Sub Stream 1 B
Sampling Frequency | 16k E

—— Attribute

Audioln Type Lineln
Noise Filter Enable E]
Microphone Volume [=] O [#] 50
SpeakerVolume (=] 0 50
Default ‘ l Refresh | | Save |
Figure 6-27
Please refer to the following sheet for detailed information.
Parameter Function
Enable You can enable audio only when video is enabled.

After selecting the “Enable” of main stream or sub stream, the
network transmission stream is the audio/video composite
stream, otherwise it only includes video image.

Encode mode The encode mode of the main stream and extra stream include
G.711A, G.711Mu, G.726 and ACC. The default mode is
G.711A.

The setup here is for audio encode mode and the bidirectional
talk encode both.

Sampling The sampling frequency of audio. It includes the following
Freqguency options:

® 38K

® 16K

® 32K

® 48K

® 64K
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Audioln Type Two modes to select: Lineln, Mic.

Device needs to connect external audio input source under
Lineln mode, and it doesn’t need to connect external audio
input source under Mic mode.

Noise Filter Enable the function and it can filter relevant noise.
Microphone Adjust microphone volume from 0~100.
Volume Note:

Supported by some devices.

Speaker Volume | aqi st speaker volume from 0~100.

Note:
Supported by some devices.

6.1.3.2 Alarm audio

@hua

Alarm Audio
> Conditions

> Video alarm1.pcm

Audio 1 o alarm2.pcm ()]
Network

Event
Storage
System

Information

Figure 6-28
Add Audio File B3
= Record = Upload
Audio File | pcm
Record
Figure 6-29
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Audio management currently supports PCM format to record and PCM, wav two forms to upload, and
can select an audio file for the audio alarm linkage.
The way to download the web alarm playback audio file into local is as follows:

Step 1 Use the left mouse button to click the hollow circle © in the “choice” column on the left, and

shows = , which means effective choice of alarm audio.

Step 2 Use the right mouse button to click L , select “save target as” to download.

6.2 Network

6.2.1 TCP/IP

The TCP/IP interface is shown as in Figure 6-30. It supports IPv4 and IPv6. IPv4 supports static IP
and DHCP. IPv6 supports static IP only. When users manually modify IP address, WEB will
automatically jump to the new IP address.

@hua

Camera TCP/IP

> Connection Ethernet Card Wire(DEFAULT) ¥

> PPPoE Hode & static © DHCP

Host Name IPC

> DDNS MAC Address

> IP Filter IP Version 1Pv4 hd

> SMTP(Email) IP Address

Z U Subnet mask

R Default Gateway

> Bonjour
Preferred DNS Server| 8 8
> Multicast
Alternate DNS Server | 8 8 4
> WIFI
IV Enable ARP/Ping to set P address service
> 802.1x

> Qos Default ‘ \ Refresh 1 I Save

Event
Storage
System

Information

Figure 6-30
Please refer to the following sheet for detailed information.
Parameter Function
Host Name It is to set current host device name. It max supports 15
characters.
Ethernet Card Please select the Ethernet port. Default is wired.
Please note you can modify the default Ethernet card if there is
more than one card.
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Mode There are two modes: static mode and the DHCP mode. Select
DHCP mode, it auto searches IP, and you cannot set IP/subnet
mask/gateway. Select static mode, you must manually set
IP/subnet mask/gateway.

Mac Address It is to display hose Mac address.

IP Version It is to select IP version. IPV4 or IPV6.

You can access the IP address of these two versions.
IP Address Please use the keyboard to input the corresponding number to

modify the IP address and then set the corresponding subnet
mask and the default gateway.

Preferred DNS

DNS IP address.

Alternate DNS

Alternate DNS IP address.

Enable
ARP/Ping set
device IP
address service.

You can use ARP/Ping command to modify or set the device IP
address if you know the device MAC address.

Before the operation, please make sure the network camera
and the PC in the same LAN. This function is on by default.

You can refer to the steps listed below.

Step 1: Get an IP address. Set the network camera and the PC
in the same LAN.

Step 2: Get the physical address from the label of the network
camera.

Step 3: Go to the Run interface and then input the following
commands.

arp —s <IP Address> <MAC>

ping -l 480 -t <IP Address>

Such as: arp -s 192.168.0.125 11-40-8c-18-10-11
ping -1 480 -t 192.168.0.125

Step 4: Reboot the device.

Step 5: You can see the setup is OK if you can see there are
output information such as “Reply from 192.168.0.125 ...” from
the command output lines. Now you can close the command
line.

Step 6: Open the browse and then input http://<IP address>.
Click the Enter button, you can access now.

6.2.1.1 Easy4ip

Click “Enable” to connect the device to network, and then you can connect to the device via mobile

client of Easy4ip after “Online” is displayed on the interface (connection mode: add device serial number
or scan QR code). See Figure 6-31.
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. TCPiP

> Connection
> PPPoE

> DDNS

> IP Filter

> SMTP(Email)
> UPnP

> SNMP

> Bonjour

> Multicast

> 802.1x

> QoS

> HTTPs
Event
Storage
System

Information

Dahua Network Camera Web 3.0 Operation Manual

TCP/IP

Easydip

"] Enable

Status Offiine
SIN 1K037FCPAW00213
QR Code (O[5

%
[

l Default I I Refresh l | Save

Figure 6-31

6.2.2 Connection

6.2.2.1 Connection

The connection interface is shown as in Figure 6-32.

@Jhua

Camera

> TCPIP

;¢ Connedtion
> PPPoE

> DDNS

> IP Filter

> SMTP(Email)
> UPnP

> SNMP

> Bonjour

> Multicast

> 802.1x

> QoS

> HTTPs
Event

Storage

System

Information

Connection

Max Connection 10 (1~20)
TCP Port 37777 (1025~65534)
UDP Port 37778 (1025~65534)
HTTP Port 80
RTSP Port 554
HTTPs Port 443
Default J | Refresh f | Save

Figure 6-32

Please refer to the following sheet for detailed information.

Parameter | Function
Max It is the max Web connection for the same device. The value ranges from 1
connection | to 20. Default connection amount is 10.

TCP port

Port range is 1025~65534. The default value is 37777. You can input the
actual port number if necessary.
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UDP port | Portrange is 1025~65534. The default value is 37778. You can input the
actual port number if necessary.

HTTP port | Port range is 1025~65524. The default value is 80. You can input the
actual port number if necessary.

RTSP port | ® The default value is 554. Please leave blank if use default. User uses
QuickTime or VLC can play the following formats. BlackBerry can play
too.

® Real-time monitoring URL format, please require real-time RTSP
media server, require channel no., bit stream type in URL. You may
need username and password.

® User uses BlackBerry need to set encode mode to H.264B, resolution
to CIF and turn off audio.

URL format is:
rtsp://username:password@ip:port/cam/realmonitor?channel=1&subtype=0
Username/password/IP and port.

The IP is device IP and the port default value is 554. You can leave it in
blank if it is the default value.

Follow standard RTP protocol and when encode mode is MJPEG, the max
resolution only supports 2040*2040.

HTTPs HTTPs communication port, range is 1025~65534, default is 443.
Port

Note:

® (0~1024, 37780~37880, 1900, 3800, 5000, 5050, 9999, 37776, 39999, 42323 are all special ports.
User cannot modify them.

® Avoid using default port value of other ports.

6.2.2.2 ONVIF

ONVIF (Open Network Video Interface Forum) , this standard describes network video mode,
interface, data type and data interaction mode. ONVIF Standard’s aim is to achieve a network video
frame agreement and makes the network video products (including video front-end, video equipment,
etc.) from different manufacturers completely compatible.

ONVIF function is on by default.
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> TCPIP Authentication ® ON () OFF

Default | l Refresh | |

> IP Filter
> SMTP(Email)
> UPnP

> SNMP

> Bonjour
> Multicast
> 802.1x
> QoS

> HTTPs
Event
Storage

System

Information

Figure 6-33

6.2.3 PPPoE

The PPPOE interface is shown as in Figure 6-34.

Enter the PPPOE username and password which are provided by ISP (Internet Service Provider), and
click “Enable”. The network camera will automatically establish network connection in the mode of
PPPOE after it is enabled; after it is successful, the IP of the “IP Address” will be automatically modified
into the dynamic IP address of the acquired WAN.

Note:

After PPPoE dial-up is successful, it needs to log in the device via the IP which is set before dial-up; in

the PPPOE setup interface, it will display the registered IP address, and then it can visit the IP address
via client.

Please disable UPnP when clicking PPPOE enable, which is to avoid causing influence to PPPoE dial-
up.
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PPPOE

[] Enable

> TCPAP
Username

> Connection
PPPOE

Password

> DDNS

> IP Filter

> SMTP(Email)
> UPnP

> SNMP

> Bonjour

> Multicast

> 802 1x

> QoS

Event

Storage

System

Information

Figure 6-34

6.2.4 DDNS

The DDNS interface is shown as in Figure 6-35.

The DDNS is to set to connect the various servers so that you can access the system via the server.
Please go to the corresponding service website to apply a domain name and then access the system
via the domain. It works even your IP address has changed. When the device connects to WLAN, you
should disable UPnP.

aJhua

TECHNOLOGY.

Camera DDNS
Net

> TCPIP [C] server Type Dahua DDNS [~]

> Connection Server Address

> PPPoE Mode @ Auto ) Manual
Domain Name dahuaddns.com
> IP Filter Usemame (Optional)Please input the mailbox
> SMTP(Email)
Default Refresh J \ Save

> UPnP H

> SNMP

> Bonjour
> Multicast
> 802.1x
> QoS

> HTTPs
Event

Storage

System

Information

Figure 6-35

Please refer to the following sheet for detailed information.
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Parameter

Function

Server Type

You can select DDNS protocol from the dropdown list: CN99
DDNS, NO-IP DDNS, Dyndns DDNS, and Dahua DDNS. The
default is Dahua DDNS.

Server Address

DDNS server IP address

CN99 DDNS

Server address: www.3322.0rg

NO-IP DDNS

Server address: dynupdate.no-ip.com
Dyndns DDNS

Server address: members.dyndns.org
Dahua DDNS

Server address: www.dahuaddns.com

Mode

Default is auto, able to choose manual

Domain Name

Both auto and manual are “MAC addresss.dahuaddns.com”by
default, able to set prefix manually.

Username

The user name you input to log in the server, optional.

The CN99 DDNS interface is shown as in Figure 6-36.

> Connection

> PPPoE

> IP Fitter

> SMTP(Email)

> UPnP

> SNMP
> Bonjour
> Multicast
> 802.1x
> QoS

Event

Storage

System
Information

DDNS

[T Server Type
Server Address
Domain Name
Usemame
Password

Update Period

CN%9 DDNS

none
none
sene

10 Minute (1~500)

Refresh

Figure 6-36
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Parameter Function

Server Type You can select CN99 DDNS protocol

Server Address | Under CN99 DDNS the default server address is “www.3322.org”

Domain Name Self-defined domain name

Username The user name you input to log in the server.

Password The password you input to log in the server

The refresh period of the connection between the device IP and the server, default

Refresh Period | 015 minutes.

6.2.5 IP filter

The IP filter interface is shown as in Figure 6-37.

You can enable IP filter function so that some specified IP/MAC user can access the network camera.
You can add IP address or IP segment.

If you do not check the box here, it means there is on access limit.

Here you can add IP address and MAC address. You must add these addresses before enabling the
trusted sites.

Please note: You must set MAC address in the same network segment.

IP Filter

Trusted Sites
> TCPIP

Trusted Sites

> Connection 1P address /MAC address
> PPPoE
> DDNS
> SMTP(Email)
> UPnP
> SNMP

> Bonjour

> Multicast

> 8021x Add IP/MAG

> Qos

‘ Default | ‘ Refresh, | ‘ Save
Event

Storage

System

Information

Figure 6-37

6.2.6 SMTP (e-mail)
The SMTP interface is shown as in Figure 6-38.
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Network
TCPIP
Port
PPPoE

>
>
>
>

DONS
SMTP(Email)
UPnP
SNMP
Bonjour
Multicast
802.1x
QoS

5 Platform
Event
Storage
System

Information
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SMTP(Email)

SMTP Server none
Port 25

[T Anonymity
Username anonymity
Password (11}
Sender none
Authentication Mone E|
Title IPC Message + [¥] Attachment
Mail Receiver

[7] Health Mail Update Period Min (30~1440)

‘ Default ‘ ‘ Refresh | | Save
Figure 6-38
Please refer to the following sheet for detailed information.
Parameter Function
SMTP Server Input server address and then enable this function.
Port Default value is 25. You can modify it if necessary.
Anonymity For the server which supports the anonymity email function, it
won'’t display the information of the sender.
User Name The user name of the sender email account.
Password The password of sender email account.
Sender Sender email address.
Authentication You can select SSL, TLS or none.
(Encryption
mode)
Title (Subject) [ Input email supject here. _
® Click the "+" sign to expand 2 terms at most for the title
from device name, device IP address, and event type.
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Parameter Function

Attachment System can send out the email of the snapshot picture once
you check the box here.

Mail receiver Input receiver email address here. Max three addresses.

Interval The send interval ranges from 0 to 3600 seconds. 0 means
there is no interval.
Please note system will not send out the email immediately
when the alarm occurs. When the alarm, motion detection or
the abnormity event activates the email, system sends out the
email according to the interval you specified here. This
function is very useful when there are too many emails
activated by the abnormity events, which may result in heavy
load for the email server.

Health mail Please check the box here to enable this function.

enable

Email test The system will automatically sent out a email once to test the
connection is OK or not .Before the email test, please save
the email setup information.

6.2.7 UPnP

It allows you to establish the mapping relationship between the LAN and the public network.
Here you can also add, modify or remove UPnP item. For UPnP on different routers, you must disable
UPNP function. See Figure 6-39.

In the Windows OS, From Start->Control Panel->Add or remove programs. Click the “Add/Remove

Windows Components” and then select the “Network Services” from the Windows Components Wizard.
Click the Details button and then check the “Internet Gateway Device Discovery and Control client” and
“UPnP User Interface”. Please click OK to begin installation.
Enable UPnP from the Web. If your UPnP is enabled in the Windows OS, the network camera can auto
detect it via the “My Network Places”.

Under manual mode, you can modify external port. Under auto mode, select idle port for auto port

mapping without user modification.
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UPnP

[C] Enable Mode | Manual E Router State Mapping Failed

Port Mapping List
> Connection

Service Name Protocol Internal Port External Port Status Modify
> PPPoE HTTP WebService TCP 80 8080 Mapping Failed A
> DDNS TCP PrivService TCP 3777 37T Mapping Failed K.
> IP Filter ubpP PrivService:UDP 37778 37778 Mapping Failed £
> SMTP(Email) RTSP RTSPService: TCP 554 554 Mapping Failed i

UPnP
> SNMP

> Bonjour

> Multicast

> 802 1x

> QoS

Event

Storage

System

Information

Figure 6-39

6.2.8 SNMP

The SNMP interface is shown as in Figure 6-40 and Figure 6-41.

The SNMP allows the communication between the network management work station software and the
proxy of the managed device. Please install the software such as MG MibBrowser 8.0c software or
establish the SNMP service before you use this function. You need to reboot the device to activate the
new setup.

Camera SNMP
TCPIP Wersion ] w [ w2 [] v3(Recommen...
Port
I SMNMP Port 161 (1~655358)
PPPoE
Read Community
DDMS
Write Community
SMTP{Email)
Trap Address
UPnP
Trap Port 162
Bonjour ‘ Default || Refresh ‘ | Save

Figure 6-40

Please refer to the following sheet for detailed information.
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Parameter

Function

SNMP Version

® Check SNMP v1, device only process vl info.
® Check SNMP v2, device only process v2 info.

® Check SNMP v3, can set username, password and
encryption method. Server calibrate corresponding
username, password and encryption method too access
device and v1/v2 are unavailable.

SNMP port

The listening port of the proxy program of the device. Itis a
UDP port not a TCP port. The value ranges from 1 to 65535.
The default value is 161

Community

Itis a string, as command between management and proxy, ,
defining a proxy, and a manager’s authentication.

Read community

Read-only access to all SNMP targets, default is public.
Note: Only number, letter, , and — supported.

Write community

Read/write access to all SNMP targets, default is private.
Note: Only number, letter, , and — supported.

Trap address

The destination address of the Trap information from the
proxy program of the device.

Trap Address

Address where to send Trap message.

Trap Port

Port which send Trap message, default is 162, range
1~65535.
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Camera
Network
TCPRIIP
Port
PPPOE
DDNS
SMTP{Email)
UFnP

Bonjour
Multicast
802.1x

Qos

SNMP
Version v
SMMP Port 161

Read Community

Write Community

Trap Address

Trap Port 162

Read-only Username | public
Authentication Type @ MDS
Authentication Pas...

Encryption Type @ CFB-AES

Platform

Storage

System

Information

Check SNMP v3 version and SNMP port, read community, write community, Trap address, Trap port

Encryption Password

Read&write Userna... private
Authentication Type @ MDS
Authentication Pas...

Encryption Type i@ CFB-AES

Encryption Passwaord

V2 v3 (Recommen...

(1~65535)

| SHA

The minimum pass phrase length is & characters

The minimum pass phrase length is & characters

| SHA

The minimum pass phrase length is & characters

The minimum pass phrase length is & characters

| Default ||

Refresh | | Save

Figure 6-41

are same with SNMP v1 and SNMP v2 versions. Only when SNMP version is SNMP v3, users need to
configure parameter in chart.

Parameter Function

SNMP Version | SNMP v3

Read-only Defaylt is public.

Username Note: .
Name only can be number, letter and underline.

Read/\Write Bg{gylt is private.

Username Name only can be number, letter and underline.

Authentication | You may select MD5 or SHA, default is MD5.

Authentication Password not less than 8 characters.

Password

Encryption Default is CFB-AES.
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Parameter Function

Encryption

Password not less than 8 characters.
Password

6.2.9 Bonjour

The Bonjour interface is shown as below. See Figure 6-42.

Bonjour is based on the multicast DNS service from the Apple. The Bonjour device can automatically
broadcast its service information and listen to the service information from other device.

You can use the browse of the Bonjour service in the same LAN to search the network camera device
and then access if you do not know the network camera information such as IP address.

You can view the server name when the network camera is detected by the Bonjour. Please note the
safari browse support this function. Click the “Display All Bookmarks: and open the Bonjour, system can
auto detect the network camera of the Bonjour function in the LAN.

Benjour

Enable
> TCPAP
Server Name PZC1EW24200002
> Connection

> PPPoE Default

> DDNS

> IP Filter

> SMTP(Email)
> UPnP

> SNMP

> Multicast

> 802 1x

> QoS

Event

Storage

system

Information

Figure 6-42

6.2.10 Multicast

The multicast interface is shown as in Figure 6-43.

Multicast is a transmission mode of data packet. When there is multiple-host to receive the same data

packet, multiple-cast is the best option to reduce the broad width and the CPU load. The source host

can just send out one data to transit. This function also depends on the relationship of the group

member and group of the outer.

Note

® Open preview, streaming media protocol, select multicast, and monitor via multicast format.

® Here you can set multicast address and port. You also need to go to Live interface to set the
protocol as Multicast.
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Multicast

Sub Stream

Main Stream
> TC

Enable Enable
> Connection
Multicast Address 224 . 1 . 2 . 4 |(224.0.0.0~239.255255.255) Multicast Address 24 . 1 2 . 4 |(224.0.0.0~239.255.255.255)
> PPPoE
Port 40000 (1025~65534) Port 40002 (1025~65534)

> DDNS
> IP Filter

> SMTP{Email) Refresh

> UPnP

> SNMP

> Bonjour

> 802 1x

> QoS
Event

Storage

System

Information

Figure 6-43

Please refer to the following sheet for detailed information.

Parameter Function

Enable Select to enable multicast function. Main stream and sub stream cannot be
used at the same time.

Multicast address Main/sub stream multicast default address is 224.1.2.4 and its range is
224.0.0.0~239.255.255.255.

Port Multicast port. Main stream is 40000, sub streaml is 40016,sub stream2 is
40032 and the range is 1025~65534.

6.2.11 4G

Note: This function is only for series with 4G module.

4G is a mobile communication system which makes wireless communication integrates with Internet
and multimedia communication.

6.2.11.1 Dialing Setting
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> TCPIP Wireless Net Type  Auto E] [v] Enable
> Connection APN 3gnet
> DDNS Authorize Mode No E]
> IP Filter Dial-up Number *99%#
> SMTP(Email) Usermname
> UPnP Password
> Biwiooe Update Period 30 S
> Multicast Time Range
> QoS
I s Nemwork Sate
IP Address
Event
Storage Wireless Signal WCDMA 0%
System FDD-LTE = 70%
Information Default | l Refresh | | Save

Wireless Net Type

Auto, WCDMA, FDD-LTE optional, you can select according
to the operator.

Enable

Check to enable 4G module.

APN

It shall be acquired from the operator according to the setup
of operator.

Authentication Mode

Auto, PAP and CHAP, the authentication algorithm is
different according to different operators.

Dial-up Number

The number is different according to different operator, it can
be acquired from operator.

User name

It shall be acquired from the operator.

Password

It shall be acquired from the operator.

Update Period

It is the period beyond the dial-up period which has been
set, it is 30s by default, which means the device can auto
acquire 4G dial-up status, cut off dial-up to save flow.

Time Range It is the time period to set dial-up. It can activate the function
via message to enable/disable dial-up function if it is
beyond the time period.

IP Address It will display the acquired IP after the dial-up is successful

via 4G.

6.2.11.2 Mobile Setting
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Camera Dialing Setting

> TCPIP [C] Message Send

> Connection Receiver
> DDNS

> IP Filter

> SMTP(Email)

> UPnP

> Bonjour

> Multicast

> QoS

Event

Storage

System

Information

Mobile Settings

[7] Message Activation [T} Phone Activation

2 Sender ™ Caller T

Title Event Message

Default | | Refresh | | Save

Figure 6-45

Please refer to the following sheet for detailed information.

Parameter

Function

Message Send

In the event, after the corresponding message activation is
enabled, it will send message to the phone of receiver when
event happens. It needs to enable the function of message
activation function in the event interface when using the
function.

Message
Activation

It can send message ON/OFF to the SIM card inside the device by
the mobile phone in the list, which is to enable /disable the dial-up
function and send REBOOT to restart the device.

Phone Activation

You can use the mobile phone in the calling list to call the SIM card
inside the device to enable dial-up function.

6.2.12 WIFI
Note:

Some series devices don’t support WIFI and WPS function.
WPS function is supported by the devices with WPS button.

6.2.12.1 WIFI
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WIFI info can show the name, status, IP information of the Current Hot Spot. Usually please “Refresh”
WIFI work information after reconnection to ensure the real-time display of the work status, because it
often takes some time to connect WIFI Hot Spot, which depends on the network signal strength.

E) L TE]
Camera

> TCPAP

> Connection
> PPPoE

> DDNS

> IP Filter

> SMTP(Email)
> UPnP

> SNMP

> Bonjour

> Multicast

> 802.1x

> QoS

Event
Storage

System
Information

e [ sews | aam_ ] __togout ]
©)

WIFI

I” Enable | Add SSID H Search SSID |

WIFIINFO
Current Hot Spot
IP address
Subnetmask
Default Gateway

Figure 6-46

WIFI setting method is as follows:

Step 1 Click

™ Enable ¥ Enable _ _
, show as , means enabling WIFI function.

Step 2 Click “ Search SSID”, and shows the wireless network hot spot of the current network camera
environment in the list.
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Camera WIFI

Netwo ¥ Enable Add SSID H Search SSID 1
> TCPAP
> Connection

> PPPoE 12345 WPA-PSK-AES
2 DONS 5370test WPAWPA2-PSK-TKIP+AES
> IP Filter
TP-LINK_465EF6 Al WPA-PSK-TKIP+AES
> SMTP(Email)
AndroidAP WPA2-PSK-AES
> UPnP
TP-LINK_425796 WPAWPA2-PSK-TKIP+AES
> SNMP

NETGEARG4 NONE
> Bonjour

> Multicast TP-LINK_NIJIAN Al WPAWPA2-PSK-TKIP+AES

N T

> 802.1x CurrentHot Spot  unconnected

> QoS IP address
Event Subnetmask
Default Gateway

Storage

System

Information

Figure 6-47

Step 3 Click “Add SSID” when need to add a wireless network manually pop out an interface in
the figure below, and enter network ID in the dialog box.

Add Wireless SSID (X!

SSID

Ok Cancel

Figure 6-48
Step 4 Double click on one can pop out the signal intensity and authentication of the hot spot.

+ Please enter the password if necessary. Please keep the choice of password index number
same as the router when entering password.

+ Please click “connect” if it is unnecessary to enter the password.

6.2.12.2 WPS
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WIFI

 Enter PIN
> TCPAP
PIN:
> Connection
SSID
> PPPOE

> DDNS
> IP Filter

€ Button

Status disconnected

> SMTP(Email) Connecting ] | Refresh
> UPnP

> SNMP

> Bonjour
> Multicast
> 802.1x
> QoS

Event

Storage

System

Information

Figure 6-49

PIN Number and SSID are both acquired from the router, please “refresh” the work information of WIFI
to ensure the real-time display of work state after filling in correctly.

6.2.13 802.1x

802.1x (port based network access control protocol) supports manual selection of authentication
method to control if device connected to LAN can join the LAN. It well supports authentication, charging,
safety and management requirement of network.

802.1x

7] Enable

Authentication
> Connection

Usemame
> PPPoE

> DDNS Password

> IP Filter

> SMTP(Email)

> UPnP

> SNMP
> Bonjour
> Mulicast
> QoS
Event

Storage

System

Information

Figure 6-50

Please refer to the following sheet for detailed information.
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Parameter Function

Authentication | PEAP (protected EAP protocol).

Username It needs the username to login, which is authenticated by the
server.
Password Please input password here.
6.2.14 QoS

The QoS interface is shown as below. See Figure 6-51.

Qos (Quality of Service) is network security mechanism. It is a technology to fix the network delay and
jam problem and etc. For the network service, the quality of service includes the transmission bandwidth,
delay, the packet loss and etc. We can guarantee the transmission bandwidth, lower the delay, and
reduce the loss of the data packet and anti-dither to enhance the quality.

We can set the DSCP (Differentiated Services Code Point) of the IP to distinguish the data packet so
that the router or the hub can provide different services for various data packets. It can select the
different queues according to the priority (64 different priority levels) of the packets and select the
bandwidth of the each queue. Level 0 is the lowest, and level 63 is the highest. It can also discard at the
different ratio when the broad bandwidth is jam.

@Jhua

Camera Qos
Network

Realtime Monitor
> TCPAP

Command
> Connection

> PPPoE

> DDNS
> IP Filter
> SMTP(Email)
> UPnP
> SNMP
> Bonjour
> Multicast
> 802 1x
[ o |
Event

Storage

System

Information

Figure 6-51
Please refer to the following sheet for detailed information.
Parameter Function
Real-time The value ranges from 0 to 63. The router or the switcher can
monitor provide different service for various data packets.
Command The value ranges from 0 to 63. The router or the switcher can
provide different service for various data packets.
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Parameter Function
Enable Check it to enable QoS.
Wireless QoS

6.2.15 Access Platform
6.2.15.1 P2P

P2P is a private network traversal technology which enables user to manage devices easily without

requiring DDNS, port mapping or transit server.

Scan the QR code with your smartphone, and then you can add and manage more devices on your

mobile client.
Step 1
Select Setting > Network > Access Platform > P2P.

The P2P interface is displayed. See Figure 6-52.

Camera P2P

» TCPIP Enable

Paort

Status Offline
PPPoE

SN JJ01682FACO0001
DONS

QR Code

SMTP(Email)
UPnF

SMNMP

Bonjour ‘ Default ‘ ‘ Refresh ‘ ‘

Multicast

802 1x

L . Y L T

L0

Access Platform

Figure 6-52

P2P is enabled by default to allow you manage your device remotely.

When P2P is enabled and the device is connected to the internet, Status will be Online. We
will then need to collect your data including IP address, MAC address, device name, device

SN and so on. All the collected data are for the purpose of remote access only. If you don't

agree, please deselect the Enable check box.
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Step 2
Select Device Management on mobile phone client.
Step 3
Select "+" at the top right corner.
Step 4
Scan the QR code on the P2P interface.
Step 5
Follow the instruction on the phone to finish configuration.
6.2.15.2 ONVIF
The ONVIF authentication is On by default, which allows the network video products (including video
recording device and other recording devices) from other manufacturers to connect to your device.
ﬂlﬂ NOTE
ONVIF is enabled by default.
Step 1
Select Setting > Network > Access Platform > ONVIF.
The ONVIF interface is displayed. See Figure 6-53.
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Camera

> TCPIIP Authentication i@ On ) Of

Fort Default Refresh ‘ |

PPPoE
DDNS
SMTP(Email)
UPnP

SMNMP

Bonjour

>
>
>
>
>
>
>
>
> 8
>0

Access Platform

Figure 6-53

Step 2
Select "On" at Authentication.
Step 3
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Click Save.
6.2.15.3 RTMP
You can connect to third party platforms with RTMP protocol to view live video.
Note:
e This configuration is only for admin user.
e RTMP only supports H.264 video and AAC audio.
Step 1
Select Setting > Network > Access Platform > RTMP.
The RTMP interface is displayed.

Camera P2P I ONVIF I RTMP _

[] Enable
Stream Type @ Main Stream ) Sub Stream 1 (") Sub Stream 2
Address Type @ MNon-custom ) Custom

DDMNS IP Address 0.0.0.0

SMTP(Email) Port 1935 (0~65535)

UPnP
f Custom Address

SNMP

Default Refresh

Bonjour

Multicast

802.1x

L . T e T

Access Platform

Figure 6-54

Step 2

Select the Enable checkbox to enable RTMP, and be sure to enter the target IP address properly.
Step 3

Configure parameters. See the following table.

Parameter Description
Stream Type Select the stream as needed.
Address Type | ® Non-custom: Enter the IP address and port of the target
platform.
® Custom: Enter the domain name that distributed by the
platform.
IP address IPv4 IP address or the domain name.
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Parameter Description
Port Keep the default value.
Custom When using custom address type, enter the domain name that
Address distributed by the platform.
Step 4
Click Save.
6.2.16 HTTPs

In the HTTPs setting interface, users can make PC log in normally via HTTPs by creating certificate or

uploading signed certificate,

which is to guarantee the security of communication data and provide

safeguard for user information and device security with reliable and stable technical means.

Step 1

Create certificate or upload the signed certificate.

® Please refer to the following steps if you select “Create Certificate”.

1. Select “Setup > Network
shown in Figure 6-55.

@Jhua

Camera

Network

> TCPIP [] Enable HTTPs

> Connection Create Certificate

PR Request Created

> IP Filter

Request Created
> SMTP(Email)

> UPnP

> SNMP Certificate Path

> Bonjour Certificate Key Path
> Multicast Certificate Installed

> 802.1x Certificate Installed
> QoS

Event

Attribute

Storage

System

Information

Install Signed Certificate

> HTTPs”, and the system will display the interface of HTTPs, which is

Browse...

Browse... | ‘

—E—

Refresh I I Save

2. Click “Create” and it will

Figure 6-55

pop out the dialog box of “HTTPs”, which is shown in Figure 6-56.
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HTTPs X
Country CN *e.q.CN
IP or Domain name | 10.15.15.211| 2
Validity Period 365 Day*Range :1-5000
Province  none
Location none
Organization ‘none
Organization Unit none
Email
Creat Cancel
Figure 6-56

3. Fillin corresponding “Country”, “Province” and some other information; click “Create” after filling in.

It will show the prompt of “Create Successfully”, which means the server certificate has been
successfully created.

Note:

Make sure the “IP or domain name” is the same as that of the device.

4. Click “Install” and it will install the certificate on the device end, which is shown in Figure 6-57.
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Camera

> TCPIP [C] Enable HTTPs

> Connection Create Certificate
ZEDNS Request Created
> IP Filter

Request Created

> SMTP(Email)
Install Signed Certificate
> UPnP

> SNMP Certificate Path
> Bonjour Certificate Key Path
> Multicast Certificate Installed

> 802.1x

Event

Certificate Installed

Attribute

Issue to: HIP=10.15.15.211; C=CN; ST=none;
L=none; O=none; OU=none; EM=;
Issuer: HAP=test, C=CN; ST=test, L=test, O=test; -
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Delete | | 3 I | Download

TS

Storage Refresh

| | Save

System

Information

Figure 6-57

5. Click “Download”. It will pop out the dialog box of “Save as”, save the file into the computer.

& Save As = - X ]
@'Q'ld » Libraries » v | ‘,‘ Search Libraries pe) |
Organize ¥ a3 v (2

Deskt - : :
I Deskiop _ Libraries
# Downloads ‘5 Open a library to see your files and arrange them by folder,...
=| Recent Places ‘_
) & Documents
4 - Libraries Sy Library
> |5 Documents
J) Music ‘ﬁ Music
b [ Pictures \/ Library
> B Videos
= Pictures
%% Library
4 M Computer -
> &y Local Disk (C) n Videos
I = DISK1_VOL2 (D:) . Library

> = DISK1_VOLS3 (E:)

File name: RootCert.cer

Save as type: | (*.cer)

“ Hide Folders

Save
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Figure 6-58

6. Double click the downloaded icon of “RootCert.cer”. The system will display the information
interface of “Certificate”, which is shown in Figure 5-55.

Certificate @

General IDetails l Certification Path |

@g Certificate Information

This CA Root certificate is not trusted. To enable trust,
install this certificate in the Trusted Root Certification
Authorities store.

Issued to: test

Issued by: test

valid from 2016/ 7/ 8 to 2020/ 7/ 7

|Insta|| Certiﬁcate...J Issuer Statement

Learn more about e

-

Figure 6-59

7. Click “Install Certificate” and it will pop out the interface of “Certificate Import Wizard”, which is
shown in Figure 6-60.
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Certificate Import Wizard &

Welcome to the Certificate Import
Wizard
This wizard helps you copy certificates, certificate trust

lists, and certificate revocation lists from your disk to a
certificate store.

A certificate, which is issued by a certification authority, is
a confirmation of your identity and contains information
used to protect data or to establish secure network
connections. A certificate store is the system area where
certificates are kept.

To continue, dick Next.

Figure 6-60

8. Click “Next”. Select “Trusted Root Certification Authorities”, which is shown in Figure 6-61.
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costene npor vt T

Certificate Store
Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can specdify a location for
the certificate.

() Automatically select the certificate store based on the type of certificate
@ Place all certificates in the following store
Certificate store:

Trusted Root Certification Authorities

Learn more about certificate stores

| <Back | nNext> | | cancel |

Figure 6-61

9. Click “Next”. The system will display the interface of “Completing the Certificate Import Wizard”,
which is shown in Figure 6-62.

90



@Qmua Dahua Network Camera Web 3.0 Operation Manual

g

Certificate Import Wizare
I — .

Completing the Certificate Import
Wizard

The certificate will be imported after you dick Finish.

You have specified the following settings:

Cerfificate Store Selected by User BRI = LGl d®=gi)ile:
Content Certificate
< 1 »

| _<Back || Fmsh | | Concel

Figure 6-62

10. Click “Finish”, and it will pop out the dialog box of “Security Warning”, which is shown in Figure
6-63.
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| X |
=

Se::urity Warning

You are about to install a certificate from a certification authority (CA)
:Ll claiming to represent:

test

Windows cannot validate that the certificate is actually from "test”. You
should confirm its origin by contacting "test". The following number
will assist you in this process:

Thumbprint (shal): 6D811FD2 E82313A8 663514ED 2CA36EGB 7D425FA6

Warning:

If you install this root certificate, Windows will automatically trust any
certificate issued by this CA. Installing a certificate with an unconfirmed
thumbprint is a security risk. If you click "Yes" you acknowledge this
risk.

Do you want to install this certificate?

Yes No

Figure 6-63

11. Click “Yes”. It will pop out the dialog box of “Import Successful”, click “Ok” to complete downloading

certificate, which is shown in Figure 6-64.

B Bl
Certificate Import Wizard M

| The import was successful,

Figure 6-64

® Please refer to the following steps if you select “Install Signed Certificate”.

1. Select “Setup > Network > HTTPs”. The system will display the interface of HTTPs, which is shown

in Figure 6-65.
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@lhua

Camera
)I 1:(.:P!|7P [T] Enable HTTPs
> Connection Create Certificate
222 Request Created

IP Filt
> (e Request Created ] | | \ Download
> SMTP(Email)

Install Signed Certificate

> UPnP
> SNMP Certificate Path z Browse...
> Bonjour Certificate Key Path Browse... | Upload |
> Multicast Certificate Installed
DIEUZ K Certificate Installed :
2itios Attribute
Event
Storage Refresh | | Save
System
Information

Figure 6-65

2. Select signed certificate and certificate key path respectively via “Browse”, click “Upload”.

3. Install root certificate, please refer to step 6~11 for more details.

4. Check “Enable HTTPs”, click “Save”. The system will display the dialog box of “Need to reboot the
device”, and then the config is valid.

Reboot

A The configuration takes effect, the device is restarting now, please don't leave this page or close the browser...

Figure 6-66

5. Use HTTPs

Use HTTPs to log in.

Enter https://xx.xx.xx.xx in the browser, and it will pop out normal login interface; the browser will prompt
certificate error if the certificate is not installed, which is shown in Figure 6-67.
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Ol - € hitps//101515211/

N—

File Edit View Favorites Tools Help

¢ Favorites | o [B] B v ] MRS v

‘ (& Certificate Error: Navigation Blocked I

[@ There is a problem with this website's security certificate.

The security certificate presented by this website was not issued by a trusted certificate authority.

Security certificate problems may indicate an attempt to fool you or intercept any data you send to the
server,

We recommend that you close this webpage and do not continue to this website.
@ Click here to close this webpage.

"if Continue to this website (not recommended).

& More information

Figure 6-67

Note:
“xx.xx.xx.xx” is corresponding to your |IP or domain name.

6.3 Event

6.3.1 Video detection
6.3.1.1 Motion Detection
Step 1

Select “Setup > Event > Video Detection > Motion Detection’ and the system will display the interface of

“Motion Detection” which is shown in Figure 6-68.
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@hua

TECHNOLOGY

Camera Motion D

Network

| videoDetection |

[”] Enable

Working Period
> Audio Detection
Anti-Dither 5 Second (0~100)
> Smart Plan
Area Eﬂ
> Vs
> Face Detection [¥] Record
> People Counting Record Delay 10 Second (10~300)
> HeatMap [7] Relay-out
> Alarm Alarm Delay 10 Second (10~300)
> Abnormality .
("] Send Email
Storage
[”] Snapshot
System
Information Default I | Refresh | l Save

Figure 6-68

Step 2

Select “Enable” to enable motion detection function.
Step 3

Set motion detection area.
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1. Click “Setup” and the system will pop out the interface of “Setting Area”, which is shown in Figure
6-69

Region £l H =

Name ; Region1 ‘
sensitivity (=) —————{}——(3) 60
Threshold (=) { (@) 5

Remaove All I | Delete I (Or Rightdick-)

Figure 6-69

2. Set area name, itis to set valid area of motion detection according to the actual situation, and it can
set the value of sensitivity and threshold respectively.
The bigger the sensitivity is, the easier it is to generate motion detection, the smaller the threshold is,
the easier it is to generate motion detection; the entire video image is the valid area of motion
detection by default.

Note:

® Different colors represent different areas; each area can set different detection area.

® The red line in the Oscillogram means triggering motion detection; green line means not triggering
motion detection.

3. Click “Save” to complete area setting.

Step 4

It is to set other parameters of motion detection, please refer to the following sheet for more details.
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Parameter

Function

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the

period range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® Press the left mouse button and drag it on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the
whole week, then it means the setup can be applied to the whole
week, you can also select the check box in front of the week number
to implement independent setting for some days).

3. Click “Save” to complete the setup of working period.

Anti-dither

System only memorizes one event during the anti-dither period. The value
ranges from 0s to 100s.

Area

1. Click “Setup” and the system will pop out the interface of “Set Area”.

2. Setthe area name, it is to set the valid area of motion detection
according to the actual situation, and it can set its sensitivity and
threshold respectively. The higher the sensitivity is, the easier it is to
trigger motion detect, the smaller the area threshold is, the easier it is
to generate motion detect, the whole video image is the valid area of
the motion detect by default.

Note:

Different colors represent different areas; each area can set different

detection areas.

The red line in the Oscillogram means triggering motion detect, the green

line means not triggering motion detect.

3. Click “Save” to complete area setup.

Record

Check it and so when alarm occurs, system will auto record. You shall set
record period in Storage>Schedule and select auto record in record control
interface.

Record Delay

System can delay the record for specified time after alarm ended. The
value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended. The
value ranges from 10s to 300s.

Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Audio linkage Check it and the system will play alarm a.udi.o file when alarm occurs._Use
can set the recorded or uploaded audio file in “camera setting > audio >
alarm audio”.

Flash linkage Check it and the flash will be on when alarm occurs, and the flash will

be off until the end of alarm after corresponding delay.
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Parameter Function
PTZ ® Here you can set PTZ movement when alarm occurs. Such as go to
preset x when there is an alarm.
® The event type includes: preset, tour and pattern.
Snapshot You need to check the box here so that system can backup motion detectior
snapshot file. You shall set snapshot period in Storage>Schedule.
Step 5

Click “Save” to complete the setting of motion detection.

6.3.1.2 Video Tampering

Step 1

Select “Setup > Event > Video Detection > Video Tampering” and the system will display the interface of

“Video Tampering” w

Camera Motion

[

> Audio Detection
> SmartPlan @]
> Vs

> Face Detection @]
> People Counting

> HeatMap w
> Alarm -

&
> Abnormality

_| Send Email

hich is shown in Figure 6-70.

Detection Jvideo Tampering]l Scene Changing

Enable Video Tampering [ Enable Defocus Detection

Working Period

Record

Record Delay 10 Second (10~300)

Relay-out

Alarm Delay 10 Second (10~300)

Snapshot

Storage

Default | | Refresh I | Save

System

Information

Figure 6-70
Step 2
Set the parameter of video tampering; please refer to the following sheet for more details.
Parameter Function
Enable video You need to check the box to enable video mask detection alarm.
tampering

Enable defocus
detection

You need to check the box to enable defocus detection alarm.
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Parameter Function

Note:

It is to set the alarm period, it can enable alarm event only during the

period range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the
whole week, then it means the setup can be applied to the whole
week, you can also select the check box in front of the week number
to implement independent setting for some days).

3. Click “Save” to complete the setup of working period.

Check it and so when alarm occurs, system will auto record. You shall set

Working Period

Record
record period in Storage>Schedule and select auto record in record control
interface.

Record Delay System can delay the record for specified time after alarm ended. The
value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended. The
value ranges from 10s to 300s.

Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Audio linkage Check it and the system will play alarm audio file when alarm occurs. Use

can set the recorded or uploaded audio file in “camera setting > audio >

alarm audio”.

Check it and the flash will be on when alarm occurs, and the flash will

be off until the end of alarm after corresponding delay.

PTZ ® Here you can set PTZ movement when alarm occurs. Such as go to
preset x when there is an alarm.

® The event type includes: preset, tour and pattern.

You need to check the box here so that system can backup motion detectior

snapshot file. You shall set snapshot period in Storage>Schedule.

Flash linkage

Snapshot

Step 3
Click “Save” to complete the setup of video tampering.

6.3.1.3 Scene Changing

Step 1

Select “Setup > Event > Video Detection > Scene Changing” and the system will display the interface of
“Scene Changing” which is shown in Figure 6-71.
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Storage

Default H Refresh H Save

System

Information

Step 2

Figure 6-71

Check “Enable” to enable the function of scene changing.

Step 3

It is to set the parameters of scene changing, please refer to the following sheet for more details.

Parameter

Function

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the

period range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the
whole week, then it means the setup can be applied to the whole
week, you can also select the check box in front of the week number
to implement independent setting for some days).

3. Click “Save” to complete the setup of working period.

Record

Check it and so when alarm occurs, system will auto record. You shall set
record period in Storage>Schedule and select auto record in record control
interface.

Record Delay

System can delay the record for specified time after alarm ended. The
value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.
Alarm Delay System can delay the alarm output for specified time after alarm ended. The

value ranges from 10s to 300s.
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Parameter Function

Send Email If you enabled this function, System can sgnd out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

PTZ ® Here you can set PTZ movement when alarm occurs. Such as go to

preset x when there is an alarm.

® The event type includes: preset, tour and pattern.

Snapshot You need to check the box here so that system can backup motion detectior
snapshot file. You shall set snapshot period in Storage>Schedule.

Step 4

Click “Save” to complete the setup of scene changing.

6.3.2 Audio Detection

Step 1

Select “Setup > Event > Audio Detection” and the system will display the interface of “Audio Detection”
which is shown in Figure 6-72.

@lhua

Camera
Network

> Video Detection
> Smart Plan

> Vs

> Face Detection
> People Counting
> HeatMap

> Alarm

> Abnormality
Storage
System

Information

Audio Detection

(] Enable Intensity Change

Sensitivity

Threshold

[”] Enable Input Abnormal

5] 0 Hs0
a 0 (Eak

Working Period

Anti-Dither

[] Record
Record Delay

[¥] Relay-out
Alarm Delay

[] Send Email

[7] Snapshot

5 Second (0~100)
10 Second (10~300)
10 Second (10~300)

Default

I

Refresh ‘ ‘ Save

Step 2

Figure 6-72

It is to set the parameters of audio detect, please refer to the following sheet for more details.
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Parameter Function
Enable input Select “Enable Input Abnormal” and it will trigger alarm when it detects
abnormal audio input abnormity.

Enable intensity
change

Select “Enable Intensity Change” and it will trigger alarm when it detects
that audio intensity change exceeds the threshold.

Sensitivity It can be judged as audio abnormity when the input volume change
exceeds continuous environment volume; users need to adjust according
to the actual environment test.

Threshold It is to set the filtered environment volume intensity, if the environmental

noise is too big, then the value needs to be set higher, users can adjust
according to the actual environment test.

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the

period range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the
whole week, then it means the setup can be applied to the whole
week, you can also select the check box in front of the week number
to implement independent setting for some days).

3. Click “Save” to complete the setup of working period.

Anti-dither

System only memorizes one event during the anti-dither period. The value
ranges from 0Os to 100s.

Record

Check it and so when alarm occurs, system will auto record. You shall set
record period in Storage>Schedule and select auto record in record control
interface.

Record Delay

System can delay the record for specified time after alarm ended. The
value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended. The
value ranges from 10s to 300s.

Send Email If you enabled this function, System can sgnd out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

PTZ ® Here you can set PTZ movement when alarm occurs. Such as go to

preset x when there is an alarm.

® The event type includes: preset, tour and pattern.

Snapshot You need to check the box here so that system can backup motion detectior

snapshot file. You shall set snapshot period in Storage>Schedule.
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Step 3
Click “Save” to complete the setup of audio detection.

6.3.3 Smart Plan

Smart plan is the master switch for intelligent analysis such as “Face Detection”, “Heat Map”, “IVS”,
“People Counting” and so on, the corresponding intelligent functions can be valid after smart plan is
enabled.

Step 1

Select “Setup > Event > Smart Plan”. The system will display the interface of “Smart Plan”, which is
shown in Figure 6-73.

@Jhua e ] c-c  a———

Camera Smart Plan &)
Network

> Video Detection
> Audio Detection

> Ivs

> Face Detection

> People Counting l Refresh “ P—

> HeatMap

> Alarm

> Abnormality

Storage

System
Information

Figure 6-73

Step 2
Click “Save” to complete the config of smart plan.

6.3.4 Intelligence Behavior Analytics

The basic requirements of scene selection.

® The total proportion of the target shall not exceed 10% of the image.

® The target size in the image can’t be less than 10 pixel x10 pixel, the size of abandoned target can’t
be less than 15 pixel x 15 pixel (CIF image); The height and width of the target can’t exceed 1/3 of
the image; it is recommended that the target height is about 10% of the image height.

® The difference of brightness value between target and background can’t be less than 10 gray levels.

® Make sure the target appears at least over 2 seconds continuously in the field; the movement
distance has to be bigger than the width of the target itself and makes sure it is no less than 15
pixels (CIF image).

103



Calaya Dahua Network Camera Web 3.0 Operation Manual

® Try to lower the complexity of the monitoring scene analysis if it is possible; it is not advised to use

IVS functions in the environment where the targets are dense and light change is very frequent.

® Try to keep away from the areas such as glass, ground reflected light, water surface, branch,

shadow, mosquito disturbance and etc. try to keep away from the backlight scene to avoid direct

light.

6.3.4.1 IVS
6.3.4.1.1 Tripwire

It will trigger alarm when the target crosses the warning line according to the movement direction which

has been set.

It needs some time from when the target appears to when the target is confirmed, so it has to leave
some space on both sides of the warning line when setting the warning line, please do not set the
warning line near the obstructions.

Application scene: it can be applied to the scene with sparse target and there is barely any blocks
between the targets, such as the unmanned perimeter protection.

Step 1

Select “Setup > Event > IVS > IVS” and the system will display the interface of “IVS”.

Step 2

Click to set rule name and select the rule type as “Tripwire”, it is shown in Figure 6-74.

Camera Vs
Network
Event Rule Type
> Video Detection [v] 1 Rule1 Tripwire v &
> Audio Detection
> Smart Plan
> People Counting
> Alarm
2 a0y Parameter Setup
Storage
System
Information
Direction A<->B -
[v] Objectfilter
Effective object (V| Human [¥] Motor Vehicle
Targetfilter @ Max Size 8191 * 8191 Draw Target [7] Record
() Min Size 0 0 Clear Record Delay | 10 s (10~300)
Pixel Counter 0 =10 Draw Target [T Relay-out
Alarm Delay 10 s (10~300)
[7] Send Email
[¥] Snapshot
Default I | Refresh l | Save
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Figure 6-74

Step 3

Click “Draw Rule” to draw tripwire in the monitoring scene, click the right mouse button to complete
tripwire setting.

Step 4

Click “Draw Target” to draw the size model of filtered target in the video image.

Step 5

Click the Draw Target behind Pixel Counter, then press and hold the left mouse button to draw a
rectangular, and then the size of the rectangular would display in the counter.

Step 6

It is to set the parameters of tripwire, please refer to the following sheet for more details.

Parameter Function

Note:

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the whole
week, then it means the setup can be applied to the whole week, you
can also select the check box in front of the week number to implement
independent setting for some days).

3. Click “Save” to complete the setup of working period.

Direction It is to set the direction of tripwire, you can select A->B. B->A. A<->B.

Working Period

Object filter Select the Obiject filter check box to enable the function, and then select the

effective object.

® Select Human, and then the alarm will be triggered if any target that fits
for the human trigger rule in the system is detected.

® Select Motor Vehicle, and then the alarm will be triggered if any target
that fits for the motor vehicle trigger rule in the system is detected.

® Select no one, and then the alarm will be triggered if any moving object
such as human, vehicle, cat, or dog is detected.

Check it and so when alarm occurs, system will auto record.

Record

Record Delay System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended.
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Parameter Function
Send Email If you enabled this function, System can sgnd out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.
Snapshot Select “Snapshot” and the system will auto trigger alarm and snapshot when
alarm occurs.
Step 7

Click “Save” to complete the setup of tripwire.

6.3.4.2 Intrusion

Intrusion includes cross and appears.

® Cross means that it will trigger alarm when the target enters or exits the area.

® Appears means that it will trigger alarm when the target appears in the area.

® As for the report interval of the IVS function in the area, the system will trigger an alarm if it detects
same event happened during the interval; the alarm counter will become zero if there is no same
event happened in the interval.

It needs to leave some space for target movement for the area periphery if it is to detect enter & exit

event, which is similar to the warning line.

Application scene; it can be applied to the scene where the target is sparse and there is barely any

obstruction between the targets, such as the unmanned perimeter protection.

Step 1

Select “Setup > Event > IVS > IVS” and the system will display the interface of “IVS”.

Step 2

Click H to set rule name, select the rule type as “Intrusion” which is shown in Figure 6-75.
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Figure 6-75

Click “Draw Rule” to draw an area in the monitoring image.

Step 4

Dahua Network Camera Web 3.0 Operation Manual

Name
Rule1

Rule Type <p

Intrusion v &

—Parameter Setup

Period

Action

Direction

[¥] Objectfilter

] Record
Record Delay

7] Relay-out
Alarm Delay

[] Send Email

[¥] Snapshot

Effective object [V] Human

[] Appears [¥] Cross

Enter&Exit v

Motor Vehicle

10 s (10~300)

10 s (10~300)

I Default I I

Refresh | [ save

Click “Draw Target” to draw the size model of filtered target in the video image.

Step 5

Click the Draw Target behind Pixel Counter, then press and hold the left mouse button to draw a
rectangular, and then the size of the rectangular would display in the counter.

Step 6

It is to set the parameters of intrusion, please refer the following sheet for more details.
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Parameter Function

Note:

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the whole
week, then it means the setup can be applied to the whole week, you
can also select the check box in front of the week number to implement
independent setting for some days).

3. Click “Save” to complete the setup of working period.

It is to set the action of intrusion, you can select appears and cross.

Working Period

Action
Direction Itis to set the direction of intrusion, you can select enter, exit and
enter&exit.
Object filter Selec_t the (_)bject filter check box to enable the function, and then select the
effective object.
® Select Human, and then the alarm will be triggered if any target that fits
for the human trigger rule in the system is detected.
® Select Motor Vehicle, and then the alarm will be triggered if any target
that fits for the motor vehicle trigger rule in the system is detected.
® Select no one, and then the alarm will be triggered if any moving object
such as human, vehicle, cat, or dog is detected.
Record Check it and so when alarm occurs, system will auto record.
Record Delay System can delay the record for specified time after alarm ended.
Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.
Alarm Delay System can delay the alarm output for specified time after alarm ended.
Send Email If you enabled this function, System can sc_and out err_1ai| to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.
Snapshot Select “Snapshot” and the system will auto trigger alarm and snapshot when
alarm occurs.
Step 7

Click “Save” to complete the setup of intrusion.
6.3.4.3 Abandoned Object

Abandoned object means the system will trigger alarm if the abandoned object in the monitoring scene
exceeds the time which has been set by the users.
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Abandoned object and missing object can be confusing in a situation where both foreground and
background are complicated.
It also triggers alarm as abandoned object if there is pedestrian or vehicle staying still for too long. In
order to filter this kind of alarm, generally the abandoned object is smaller than people and vehicle;
therefore it can filter the people and vehicle via setting size. Besides, it can avoid the false alarm caused
by short stay of people via extending alarm time properly.
Application scene: It can be applied to the scene where the target is sparse and there is no obvious and
frequent light change. False alarm will be increased in the scene with high target density and frequent
blocking; false alarm will be increased in the scene where there are more people staying. As for the
detection area, try to make it simple, the function is not suitable for the area which is too complicated.
Step 1
Select “Setup > Event > IVS > IVS” and the system will display the interface of “IVS”.
Step 2

Click to set rule name, select the rule type as “Abandoned Object” which is shown in Figure 6-76.

@Jhua

Camera

Network

No. Rule Name Rule Type

¥ 1 Rulet Abandoned Ob[v| @ *

2015-03-31 1341.5¢
> Video Detection
> Audio Detection
> Smart Plan

> Face Detection - " o L [ Parameter Setup

> People Counting 3 | i "~ Working Period
> HeatMap f |
> Alarm Keep Time 10 Second (6~3600)
> Abnormality ————
Storage = 1L [7] Record
System - i~ — Record Delay | 10 Second (10~300)
Information [7] Relay-out
Alarm Delay 10 Second (10~300)
TargetFilter @ Max Size * [[] send Email
©) Min Size = Gt
| Default || Refresh H Save
Figure 6-76
Step 3
Click “Draw Rule” to draw an area in the monitoring area.
Step 4
Click “Draw Target” to draw the size model of filtered target in the video image.
Step 5

It is to set the parameter of abandoned object, please refer to the following sheet for more details.
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Parameter Function

Note:

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the whole
week, then it means the setup can be applied to the whole week, you
can also select the check box in front of the week number to implement
independent setting for some days).

3. Click “Save” to complete the setup of working period.

Working Period

Keep time It is to set the shortest time from when the object is abandoned to when it
triggers alarm.

Record Check it and so when alarm occurs, system will auto record.

Record Delay System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so

that system can activate corresponding alarm device when alarm occurs.

System can delay the alarm output for specified time after alarm ended.

Alarm Delay
Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.
Snapshot Select “Snapshot” and the system will auto trigger alarm and snapshot when
alarm occurs.
Step 5

Click “Save” to complete the setup of abandoned object.

6.3.4.4 Missing Object

Missing object means the system will trigger alarm if it exceeds certain amount of time after the target is
taken away from the original scene.

The system can make statistics of the still areas in the foreground area and distinguish if it is missing
object or abandoned object according to the similarity between foreground and background, it will
trigger alarm when it exceeds the time which is set by users.

Because the system distinguishes abandoned object from missing object according to the similarity of
foreground and background, it may cause error between abandoned object and missing object in a
situation where both foreground and background are complicated.

Application scene: it can be applied to the scene where the target is sparse and there is no obvious and

frequent light change. False alarm will be increased in the scene where the target density is high and
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there is frequent obstruction; the false alarm will be increased in the scene where there are more people
staying. As for the detection area, try to make it simple, the function is not suitable for the area which is
too complicated.

Step 1

Select “Setup > Event > IVS > IVS” and the system will display the interface of “IVS”.

Step 2

Click to set rule name and select rule type as “Missing Object”, which is shown in Figure 6-77.

@Jhua

Camera

etwert 2015-0-31 13:41:50 flo Rulsiiame Sl lge i
e M 1 Rulet Missing Object[~| @ *
> Video Detection
> Audio Detection
> Smart Plan
E
> Face Detection = “ e |- Parameter Setup
> People Counting , Working Period
> HeatMap | -
> Alarm = Keep Time 10 Second (6~3600)
> Abnormality = E
storage o [] Record
System = = p—— Record Delay | 10 Second (10~300)
Information [”] Relay-out
Alarm Delay 710 Second (10~300)
TargetFilter @ Max Size « 1 [] send Email
) Min Size * | Stapiiot
I Default H Refresh “ Save
Figure 6-77
Step 3
Click “Draw Rule” to draw an area in the monitoring scene.
Step 4
Click “Draw Target” to draw the size model of filtered target in the video image.
Step 5

It is to set the parameters of missing object, please refer to the following sheet for more details.
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Parameter

Function

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the whole
week, then it means the setup can be applied to the whole week, you
can also select the check box in front of the week number to implement
independent setting for some days).

3. Click “Save” to complete the setup of working period.

Keep time

It is to set the shortest time from when the object is missing to when it
triggers alarm.

Record

Check it and so when alarm occurs, system will auto record.

Record Delay

System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended.

Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Snapshot Select “Snapshot” and the system will auto trigger alarm and snapshot when
alarm occurs.

Step 5

Click “Save” to complete the setup of missing object.

6.3.5 Face Detection

Step 1

Select “Setup > Event > Face Detection” and the system will display the interface of “Face Detection”,
which is shown in Figure 6-78.
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Figure 6-78
Step 2
Select “Enable” to enable face detection function.
Step 3
Click “Draw Target” to draw the size model of target filter in the video image.
Step 4
It is to set the parameters of face detection, please refer to the following sheet for more details.
Parameter Function
Note:

Working Period

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.

1. Click “Setup” and the system will pop out the interface of “Working
Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the whole
week, then it means the setup can be applied to the whole week, you
can also select the check box in front of the week number to implement
independent setting for some days).

3. Click “Save” to complete the setup of working period.

Select “Enable Face Enhancement” and it will guarantee that the face is

Enable Face o .
Enhancement clear by priority when the stream is set very low.
Record Check it and so when alarm occurs, system will auto record.

Record Delay

System can delay the record for specified time after alarm ended.
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Parameter Function

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended.

Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Snapshot Select “Snapshot” and the system will auto trigger alarm and snapshot when

alarm occurs.

Step 5
Click “Save” to complete the setup of face detection.

6.3.6 People Counting

6.3.6.1 People Counting

Step 1

Select “Setup > Event > People Counting > People Counting” and the system will display the interface
of “Entrance/Exit”, which is shown in Figure 6-79.

No. Name Rule Type L
@ 1 Rule1 People Counting v &

> Video Detection

-Parameter Setup -

> Audio Detection

> Smart Plan -
[v] Enter No.
[v] Leave No.
Storage —
- <
system Sensitivity =] O 7
Information Flip Inclined ¥,
Flowrate Alarm
Leave No. 0
Standed No. 0
["] Record
Record Delay 10 s {10~300)
[T Relay-out
Alarm Delay 10 s {10~300)
["] send Email
[V] Snapshot
| Default I | Refresh I | Save

Figure 6-79

Step 2
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Select “Enable” to enable statistics function of entrance and exit.

Step 3

Click “Draw Rule” to draw an area in the monitoring image.

Step 4

Click “Draw Target” to draw the size model of filtered target in the video image.

Step 5

It is to set the parameters of entrance and exit, please refer to the following sheet for more details.
Parameter Function
0SD Select the Enter No. or Leave No. check box to display the number of the

people that enter or leave this area.

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.
1. Click “Setup” and the system will pop out the interface of “Working

Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the whole
week, then it means the setup can be applied to the whole week, you
can also select the check box in front of the week number to implement
independent setting for some days).
3. Click “Save” to complete the setup of working period.

Sensitivity

Configure the alarm sensitivity, and the bigger the sensitivity value is, the
easier the alarm will be triggered.

Flip

Select from the list to rotate the image, and you can select Inclined or
Vertical.

Flowrate Alarm

It is to set the enter number, leave number, stranded number; it will trigger
alarm when it exceeds the limited number.

Record

Check it and so when alarm occurs, system will auto record.

Record Delay

System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended.

Send Email If you enabled this function, System can sc_end out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Snapshot Select “Snapshot” and the system will auto trigger alarm and snapshot when
alarm occurs.

Step 6

Click “Save” to complete the setup of people counting.

115



Cal!m’oya Dahua Network Camera Web 3.0 Operation Manual

6.3.6.2 In Area No.
Step 1

Select “Setup > Event > People Counting > People Counting” and the system will display the In Area
No. interface, which is shown in the following figure.

> Video Detection
> Audio Detection

> Smart Plan

No. Name Rule Type CH]
[v] 1 Rule1 In Area No. - -
Parameter Setup

0sD

[7] Inside Number

> Abnormality -
SEage Sensitivity = 0 7
System Flip Inclined -
Information [V] Regional Number Statistics Al...
Inside Number 30 (0~30)
Draw Area Clear Type =Threshold v
[7] stranding Alarm
Stranding Time 30 s (1~1800)
] Record
Record Delay 10 s (10~300)
7] Relay-out
Alarm Delay 10 s {10~300)
[7] Send Email
[v] Snapshot
| Default I ] Refresh I I Save
Step 2
Select “Enable” to enable statistics function of entrance and exit.
Step 3
Click “Draw Area” to draw an area in the monitoring image.
Step 4
It is to set the parameters of entrance and exit, please refer to the following sheet for more details.
Parameter Function
0SD Select the Inside Number check box to display the number of the people
that in this area.
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Parameter

Function

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.
1. Click “Setup” and the system will pop out the interface of “Working

Period”.

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to
drag on the setup interface to set.

® There are six periods to be set every day, select the check box in front
of the period, and then the period is valid.

® Select week number (it selects Sunday by default, if it selects the whole
week, then it means the setup can be applied to the whole week, you
can also select the check box in front of the week number to implement
independent setting for some days).
3. Click “Save” to complete the setup of working period.

Configure the alarm sensitivity, and the bigger the sensitivity value is, the

Statistics Alarm

Sensitivity X ; !
easier the alarm will be triggered.
Flip Select from the list to rotate the image, and you can select Inclined or
Vertical.
Regional Select the check box to enable this function, and then define the Inside
Number Number and Type. There are two options in the Type list.

® Select 2Threshold, and then the alarm will be triggered if the number
of the people.in the area is greater than or equal to the defined number.

® Select <Threshold, and then the alarm will be triggered if the number
of the people.in the area is lower than or equal to the defined number.

Stranding Alarm

Select the check box to enable this function, and then when people stay in
this area for longer than the defined time period, the alarm will be triggered.

Record

Check it and so when alarm occurs, system will auto record.

Record Delay

System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended.

Send Email If you enabled this function, System can sgnd out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Snapshot Select “Snapshot” and the system will auto trigger alarm and snapshot when
alarm occurs.

Step 5

Click “Save” to complete the setup of people counting.

6.3.6.3 Report

It is to generate a form of report according to the number statistics.

Step 1
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Select “Setup > Event > People Counting > People Counting Report “and the system will display the
interface of People Counting Report, which is shown in Figure 6-76.

Camera
Network
Event

> Video Detection

> Audio Detection

> Smart Plan

Rule  In Area No. -

Report Type  Daily - Begin Time | 2018-10-23 i 00 00 0o EndTime  2018-10-23 i 16 0o 0o +Daily report max range is 24 hours.

Stranding Time @ 5s 30s 60s ReportType @ Bar Chart Line Chart

. S le Counti —
Figure 6-76
Step 2
It is to set search condition, please refer to the following sheet for more detalils.
Parameter Note
Rule Select the rule you need.
Report Tvpe Can select day report, month report, or year report; also can select bar chart or line
P yp chart to display the report.
Time It can set the begin /end time within the range of statistics time.
Stranding This option displays if you select the In Area No. rule, and you can select the report
Time with the stranding time you need.

Flow Direction

This option displays if you select the People Counting rule, and you can select
enter, leave and display number; the data of checked item can be displayed in the
report.

Report Type You can select from Bar Chart report or Line Chart report.
Search Search flow statistics data according to the setting to form report.
Export Export the saved report.

Step 3

Click “Search” to complete report statistics, click “Export” to export the report.

6.3.7 Heat Map

6.3.7.1 Heat Map

It is the density statistics of moving object that can generate report, the color range is from blue to red,
blue means the min heat value and red means the max heat value.

Mirroring, view angle change and heat map original data will be cleared.

Step 1

Select “Setup > Event > Heat Map > Heat Map” and the system will display the interface of “Heat Map”,
which is shown in Figure 6-80.
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Default

| I Refresh

Save

Step 2

Select “Enable” to enable heat map function.

Step 3

It is to set the working period.

1. Click “Setup” and the system will display the interface of “Working Period”, which is shown in

Figure 6-81.

Figure 6-80
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Figure 6-81

2. ltis to set working period according to the following methods:

® You can input time numerical value or press the left mouse button to drag on the setup interface to
set.

® There are six periods to be set every day, select the check box in front of the period, and then the
period is valid.

® Select week number (it selects Sunday by default, if it selects the whole week, then it means the
setup can be applied to the whole week, you can also select the check box in front of the week
number to implement independent setting for some days).

3. Click “Save” to complete the setup of working period.

Step 4
Click “Save” to complete the setup of heat map.

6.3.7.2 Report

It is to generate the form of report according to the heat map data.

Step 1

Select “Setup > Event > Heat Map > Report” and the system will display the interface of “Report”, which
is shown in Figure 6-82.

@lhua

Camera Heat Map

Network
Start Time | 2016-05-23 7| 00 EndTime | 2016-05-23 | 16 *Report Max Range Is 1 Week
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Figure 6-82

Step 2
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Itis to set begin time and end time.

Step 3

Click “Search” to complete report statistics, click “Export” to export the statistics report.

6.3.8 Alarm

Please note some series products do not support this function.

5.3.2.1 PIR alarm

The alarm activation interface PIR alarm is shown as in Figure 6-83.

Carnara PIR Alarm

Network I” Enable

Working Period

> Video Detect

S Auxss Deter Anti-Dither

> IVS Analyse IV Flash

> Face Detect Flash Delay

> People Counting IV Record

> Heat Map Record Delay
Alarm V¥ Relay-out

> Abnormality Alarm Delay

Storage I” Send Email

System

I" Audio Linkage

Information I~ Snapshot

Relay Activation Flash Set Audio Detect

0 ~ Second (0~100)
10 Second (10~300)
10 Second (10~300)
10 Second (10~300)

Default | \ Refresh | \ Save

Figure 6-83

Please refer to the following sheet for detailed information.

Parameter

Function

Enable

After enabled, relay activation will work. Check it and enable the
PIR alarm.

Working
period

® This function becomes activated in the specified periods.

® There are six periods in one day. Please draw a circle to
enable corresponding period.

® Select date. If you do not select, current setup applies to
today only. You can select all week column to apply to the
whole week.

® Click OK button, system goes back to motion detection
interface; please click save button to exit.

Note: User can set via dragging mouse while not releasing left

mouse.

Anti-dither

System only memorizes one event during the anti-dither period.
The value ranges from 0s to 100s.
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Flash After enabling, the system will automatically turn on the flash
when alarm occurs.

Flash Delay e The flash will be off with a period of time delay when the
alarm linkage is over.

e Time is calculated by unit of second and ranges from
10s~300s.

Record System auto activates motion detection channel to record once
alarm occurs (working with motion detection function).

Record Delay | System can delay the record for specified time after alarm ended.
The value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output
port so that system can activate corresponding alarm device when
alarm occurs.

Alarm delay System can delay the alarm output for specified time after alarm
ended. The value ranges from 10s to 300s.

Send Email After this function is enabled, system can send out email to alert
you when alarm occurs and ends.

Audio Linkage | Check it and the system will play alarm audio file when alarm
occurs. Users can set recorded audio file in “Camera Setting >
Audio >Alarm Audio”.

Snapshot After you enabled snapshot, the system will automatically
snapshot if alarm occurs.

6.3.8.1 Alarm Linkage

Camera PIR Alarm Relay Activation Flash Set Audio Detect

o I” Enable

Relay-in Alarm1 N
> Video Detect
> Audio Detect Waiking Beriod

> IVS Analyse Anti-Dither 0 Second (0~100)  SensorType [NO v

Event

> Face Detect I Flash
> People Counting
> Heat Map

> Abnormality

Flash Delay 10 Second (10~300)
V¥ Record

Record Delay 10 Second (10~300)
IV Relay-out

Storage
Alarm Delay 10 Second (10~300)

System

I” Send Email
Information
™ Audio Linkage

" Snapshot

Default l | Refresh | | Save
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Figure 6-84

Parameter Function
Enable Check it and enable the alarm linkage.
Relay-in The default alarm 1, some products can choose alarm 2.

Two types of sensor which are normally open (NO) and normally closed (NC),
Sensor Type switch from normally open to normally closed, open the alarm. Switch from normally

closed to normally open, shut the alarm.

Check it and set PTZ movement when alarm occurs. Such as go to preset x when
PTZ there is an alarm.

The event type includes: preset, tour and pattern and so on.

6.3.8.2 Flash Set

@hua

Camera
Network

> Video Detect

> Audio Detect

> IVS Analyse

> Face Detect

> People Counting
> HeatMap

> Abnormality
Storage
System

Information

L uve | rapack ] sewe | mam [ _tosout

PIR Alarm Relay Activation Flash Set Audio Detect

m Weak (=) 0 Strong

v Al

¥ Sunday ™ Wonday ™ Tuesday ™ Wednesday ™ Thursday W Friday ¥ Saturday

¥ Period 1: 00 00 : 00 23 : 59 : 59

[ petaut [ Refesh ][ sae

Figure 6-85

Parameter

Function

ON/OFF

ON means flash is on; OFF means flash is off.

Weak-strong
bar

Via dragging this bar to adjust flash brightness.

All

Check and it means the day flash works.

Period

Period that flash is on.
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6.3.8.3 Audio detection

Note: Audio detection won’t work when “Talk” is enabled on the preview interface.

[TTI rTT ST ST ST

PIR Alarm Relay Activation Flash Set Audio Detect
Camera

Network I” Enable

Event Threshold = 50

e Working Period

> Audio Detect

> IVS Analyse " Flash

> Face Detect Flash Delay Second (10~300)

> People Counting ¥ Record

> Heat Map Record Delay Second (10~300)
Alarm | ¥ Relay-out

> Abnormality Alarm Delay Second (10~300)
Storage I” Send Email

System I Audio Linkage
Information

" Snapshot

perautt,_ ][ Refresn

Figure 6-86
parameter Function
Enable Check it and enable audio detection.
Threshold Ittr\]/\r/gls;[]r(l)?ger alarm and set up a series of linkage when volume exceeds the set

6.3.9 Abnormity

Abnormity includes No SD Card, Capacity Warning, SD Card Error, Disconnection, IP Conflict and
Unauthorized Access.

Note:

Only device with SD card function has these three statuses: No SD card, capacity warning, and SD card

error. Device without SD card function does not have the above three statuses. See Figure 6-87 to
Figure 6-89.
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TECHNOLOGY

Camera SD Card

Network llegal Access

Network
= Event Type No SD Card [~]
> Video Detection [] Enable
> Audio Detection [v] Relay-out
> Smart Plan Alarm Delay 10 Second (10~300)
> Vs [~] Send Email
> Face Detection
Default ‘ | Refresh | | Save
> People Counting
> HeatMap
> Alarm

Storage
System
Information

Figure 6-87

@Jhua

Camera SD Card

liegal Access
Network

= t Event Type SD Card Error E|

> Video Detection [T] Enable

> Audio Detection [v] Relay-out

> SmartPlan Alarm Delay 10 Second (10~300)
> vs ("] Send Email

> Face Detection

Default Refresh

> People Counting

> HeatMap

> Alarm

=

Storage

System

Information

Figure 6-88
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@Jhua

Camera SD Card

Network

liegal Access

Event Event Type Capacity Waming E]
> Video Detection [[] Enable
> Audio Detection Capacity Limit 10 %(0~99)
> Smart Plan [V] Relay-out
> VS Alarm Delay 10 Second (10~300)
> Face Detection [7] Send Email
> People Counting
Default 1 \ Refresh ‘ \ Save

> HeatMap

> Alarm

System

Information

Figure 6-89
Please refer to the following sheet for detailed information.
Parameter | Function
Enable Check to alarm when SD card is abnormal.
Relay-out Check to enable relay-out alarm.
Relay out | The alarm output can delay for the specified time after alarm stops. The
delay value ranges from 10s to 300s.
Note:
No SD card, capacity warning, SD card error, relay-out delay all start
from alarm occurs.
Send After you enabled this function, the system can send out email to alarm
email the specified user.
This function is invalid when network is offline or IP conflict occurs.
SD Card User can set SD card capacity that is left free. When SD card space left
Capacity | is smaller than this limit, alarm occurs.
Limit

When device is offline or IP conflicts, the abnormal alarm is similar with case of SD card error.
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TECHNOLOGY

Camera SD Card Network

llegal Access

Network

Event Type Disconnection El
> Video Detection V] Enable
> Audio Detection "] Record
> Smart Plan Record Delay 10 Second (10~300)
> vs ] Relay-out
> Face Deteclion Alarm Delay 10 Second (10~300)
> People Counting

Defauit | | Refresh | | Save

> HeatMap
> Alarm

Storage

System

Information

Figure 6-90

When login password keep been wrong for a few times, unauthorized access alarm occurs. This
operation is similar to SD card error. Allow login error times as when it exceeds this limit, user account

will be locked.

@lhua

Network

Camera SD Card
Network

llegal Access

Event [v] Enable

> Video Detection Login Error 3 time (3~10)

> Audio Detection [¥] Relay-out

> SmartPlan Alarm Delay 10 Second (10~300)
> Iv8 [] Send Email

> Face Detection
peraut__||

Refresh j | Save

> People Counting
> HeatMap

> Alarm

Storage

System

Information

Figure 6-91

6.4 Storage Management

6.4.1 Schedule
Before schedule setup, user must set record mode is auto or manual.

Note:

If record mode in record control is off, then device will not take snapshot according to schedule.
6.4.1.1 Record Schedule

Record schedule steps:

Step 1. Click on Record Schedule, see Figure 6-92.
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Record Schedule

General |l Motion Alarm Il
0 2 4 6 8 10 12 14 16 18 20 22 24
Sunday Setup
Menday S
> Destination =
» Record Control L=ty
System \Wednesday Setup
Information Thursday
Friday Selup
o
Holiday Setup
peut || memesn || saw

Step 2. From Monday to Sunday select record time, click on setup on the right, see Figure 6-93.
® Set period according to actual need. There are six periods available each day.
® By checking or unchecking, you can add or delete three types of record schedule: General, Motion,

and Alarm.
Note:
Period setup can be done by dragging in record schedule interface while not releasing left mouse.
Setup %]
Y ¥ sunday I Monday I Tuesday I Wednesday I Thursday [ Friday [ Saturday I Holiday
Feriod 1: 00 - 00 : 00 |-| 23 : 89 : 59 | [T General W Motion ¥ Alarm
Period 2: 00 : 00 : 00 |-| 23 : 59 : 59 | [T General I motion I Alarm
Period 3: 00 - 00 : 00 |-| 23 : 59 : 59 | [T General [T Mmaotion I Alarm
Feriod 4: 00 : 00 : 00 |-| 23 : 89 : 59 | [T General I Motion I Alarm
Period 5: 00 - 00 : 00 |-| 23 : 59 : 59 | [ General [T Maotion [ Alarm
Feriod &: 00 : 00 : 00 |-| 23 : 89 : 59 | [T General I Motion I Alarm
Save ‘ ‘ Cancel |
Figure 6-93

Step 3. Click on OK, return to record schedule interface. See Figure 6-94.
® Green color stands for the general record/snapshot.

® Yellow color stands for the motion detect record/snapshot.

® Red color stands for the alarm record/snapshot.
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Camera Record Schedule Snapshot Schedule Holiday Schedule

Network General | Motion Alarm W
Event
0 2 4 B a8 10 12 14 16 18 20 2 24
SundayI\I\I\I\I\I\I\I\I\I\I\I\I\I\I\I\I\I\I\I\I\I\I\I\I Setup
System e —————————————————
Information Thursday m
Friday Setup
S ————————————————
tup
Holiday Setup
| Default H Refresh H Save |

Step 4. In record schedule interface, click on OK. System prompts it is successfully saved.

6.4.1.2 Snapshot Schedule
Snapshot setup as:
Step 1. Click on Snapshot Schedule tab, see Figure 6-95.

@hua

Camera Record Schedule Snapshot Schedule Holiday Schedule
Network

General |l Motion Alarm W
Event

> Destination

=)

2 4 6 8 10 12 14 16 18 20 22 24
T T T T T T T T A A A |

Sunday Setup

Monday =

w

EE

Tuesday ef

> Record Control

system Wednesday Setup

Information Thursday

E

1

Friday

Setup
Saturday

e

|

Holiday

Setup

Deiault

Refresh

Save

Figure 6-95

Step 2. From Monday to Sunday select snapshot time, click on setup on the right. See Figure 6-96.
® Set snapshot period according to actual need. There are six periods available each day.
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® By checking or unchecking, user can add or delete three types of snapshot schedule: General,
Motion and Alarm.
Note: Period setup can be done by dragging in snapshot schedule interface while not releasing left
mouse.

Setup %]
T A ¥ sunday T Monday I Tuesday [ Wednesday [ Thursday [ Friday [ Saturday [T Holiday
Period 1: 00 : 00 : 00 |-| 23 : 89 : A9 | [ ceneral W mMotion [ Alarm
Period 2; 00 - 00 : 00 |-| 23 : 59 : 59 | [ cGeneral I Motion [ Alarm
Period 3: 00 - 00 : 00 |-| 23 : 59 : 59 | I[” ceneral I~ Motion [~ Alarm
Period 4: 00 : 00 : 00 |-| 23 : 89 : A9 | [ ceneral I mMotion [ Alarm
Period 5: 00 - 00 : 00 |-| 23 : 59 : 59 | [ cGeneral I Motion [ Alarm
Period 6 00 - 00 : 00 |-| 23 : 59 : 59 | I[” ceneral I~ Motion [~ Alarm
Save | | Zancel |
Figure 6-96

Step 3. Click on OK, return to snapshot schedule interface. See Figure 6-97.
® Green color stands for the general record/snapshot.

® Yellow color stands for the motion detect record/snapshot.

® Red color stands for the alarm record/snapshot.

@lhua

Camera Record Schedule

REREL General |l Motion Alarm W
Event
o 2 4 i} a2 10 12 14 16 138 20 22 24
Schedule
> Destination
Tuesd:
> Record Control ] Sohp
system Wednesday
Information isis)
Friday Setup
e
Holiday Setup
peaut || Revesn || Save

Step 5. In snapshot interface, click on OK. System prompts it is successfully saved.
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6.4.1.3 Holiday Schedule
Holiday schedule can set specific date as holiday.
Step 1. Click on Holiday Schedule tab, see Figure 6-98.

@hua

Camera Record Schedule

PEENELT [C] Record [T] Snapshot

Calendar

Sun Mon Tue Wed Thu Fri Sat

Event

Storage

» Destination 1 2 3 4 5 6
> Record Control 7 3 g 10/ (11 [12] |13
System
Information

Retesh || save

Figure 6-98

Step 2. Select date to set as holiday. The selected date will be highlighted in yellow.

Step 3. Check Record/Snapshot, click on Save. System prompts it is successfully saved.

Step 4. Check Record Schedule/Snapshot Schedule interface, click on setup next to Holiday, and refer
to setup of Monday to Sunday.

Step 5. Complete setup of holiday, then it records/snapshots according to date in holiday schedule.

6.4.2 Destination

6.4.2.1 Path

The destination interface is shown as in Figure 6-99.

Path can config record and snapshot storage path. There are three options: Local, FTP and NAS. You
can only select one mode. System can save according to the event types. It is corresponding to the
three modes (general/motion/alarm) in the Schedule interface. Please check the box to enable the save
functions.

Note: Only device supports SD card has local.
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Camera Path

SEEE Record snapshot
EXE Event Type Scheduled Motion Detect Alarm Event Type Scheduled Motion Detect Alarm
Local Local
P SERIEILD FTP &) &} O FTP O 0 ]
B B g s 0 5 g
» Record Control
‘ Default H Refresh H Save
System
Information
Figure 6-99
Please refer to the following sheet for detailed information.
Parameter | Function
Event It includes: scheduled, motion detect and alarm.
Type
Local It saved in the SD card.
FTP It saved in the FTP server.
NAS It saved in NAS disk.
6.4.2.2 Local

The local interface is shown as in Figure 6-100.

Here you can view local Micro SD card or NAS disk information. You can also operate the read-only,
write-only, hot swap and format operation.

Note:

If you use Dahua SD card, make sure it is authenticated first.

Camera

Network

Event Disk1 General Read & Wiite Enerypion — 14852 5M/15075 301

[ Reasony ][ measswme || roswap ][ memesn |
[ [ ][ o] [ Gerpassnee
Figure 6-100
For the description of the SD card properties and the buttons, see the following table.
Property Description
Name The name of your SD card, and it cannot be modified.
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Property Description

Status ® Normal: The SD card is ready for use.

® Error: You might need to remove the SD card and insert it again
or format the card.

Attribute ® Click Read Only to change the SD card to read only.
® Click Read & Write to change the SD card to read and write.

Mode The Mode is only displayed when you use Dahua SD card.

® Normal: The SD card is new or has not been encrypted, you
need to click Encryption to configure a password for the SD
card, and then the mode will change to Authentication.

® Unauthenticated: If you encrypted an SD card on one camera,
and then put the SD card in a different camera, the mode will be
Unauthenticated, and you need to click Authentication to
enter the SD card password to authenticate the SD card.

Note:

You can keep 10 authenticate information at most in one
camera, and if there are more than 10 SD cards being
authenticated, the new information would overwrite the oldest
one.

® Authentication: The SD card is encrypted or authenticated and
is ready for use.

Used The used space and total space of the SD card.

Capacity/

Total

Capacity

Health Info The Health Info is only displayed when you use Dahua SD card.

There will be different colors indicates different health statuses of the
SD card.

® Green: Excellent status
® Blue: Good status

® Orange: Medium status
)

Red: The SD card is probably too old, you might need to
change to a new card.

Hot Swap Click this button, and then you can remove the SD card.
Refresh Click to display the latest configuration.
Encryption These items are only displayed when you use Dahua SD card.

Authentication | ® Click Encryption to configure a password for the SD card.
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Property Description

Modify ® Click Authentication to authenticate the SD card.
Password ® Click Modify Password to change the SD card password.
Clear ® Click Clear Password to erase the SD card password.

Password Note:

If you enter wrong password for 5 consecutive times, then you need
to wait 5 min to do the operation again, and no authentication,
password modification or erase can be done during that 5 min.

Format Click to format the SD card.

6.4.2.3 FTP

The FTP interface is shown as in Figure 6-101.
You need to check the box to enable the FTP function. When network disconnect occurred or there is

malfunction. Emergency storage can save the record/snapshot picture to the local SD card. Click the
test button to check if the FTP server can be connected for test.

@lhua

Camera Path
Network

Enable
Server Address

2 Port 21 (0~65535)
> Schedule
User Name anonymity
> Record Control Foswond
Remote Directory share

System

Information Emergency (Local)
[ oeraut |[  Reesn [ saw
Figure 6-101

6.4.2.4 NAS

You need to check the box to enable the NAS function. Select NAS storage, fill in NAS server address
and corresponding store path, then you can store video file or pictorial information in the NAS server.
See Figure 6-102.
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Enable
Event
Server Address

Storage

Remote Directory
> Schedule

> Record Contral

System

Information

Figure 6-102

Parameter Function

Server Address | Set IP address of NAS server.

Remote Set storage directory, videos and pictures can be stored in to corresponding server
Directory directory.

6.4.3 Record control

The record control interface is shown as in Figure 6-103.
Note:

If you use Dahua SD card, make sure it is authenticated first.

Network
*lt needs to make sure SD card is authenticated before enabling recording function.
Pack Duration 8 Min. (1~120)
Pre-event Record g 5 (0~5)
: Disk Full Stop |~
Record Control Record Mode () Auto @ Manual ) Off
System Record Stream Main Stream E
Information
Default | ‘ Refresh | ‘ Save
Figure 6-103

Please refer to the following sheet for detailed information.
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Parameter Function

Here you can select file size within 1min~120min. Default setup is 8
minutes.

Pack
Duration

Pre-record | Please input pre-record value here.

For example, system can record the four seconds video in the buffer.
The record begins from the fifth second.

Note:

Configure pre-record time, when alarm or motion detection occurs, if
there is no record, system will record the preceding n seconds
record.

Disk Full There are two options: stop recording or overwrite the previous files
when HDD is full.
® Stop: Current working HDD is overwriting or current HDD is full,

it will stop record.
® Overwrite: Current working HDD is full; it will overwrite the

previous file.
There are three modes: Auto/manual/close.

Record
mode

Record There are two options: main stream and sub stream.

stream

6.5 System

6.5.1 General
The General interface is shown as in Figure 6-104.

aJhua

TECHNOKS

Date&Time

Camera General

Network

'YZC4DZ021W00009

Event
Language English El

Storage
Video Standard PAL [~]

Device Name

TvOut Open [Z|

> Account Default ‘ | Refresh | | Save

> PTZ Settings

> Default
> Import/Export

> Auto Maintain

> Upgrade

Information
Figure 6-104
Please refer to the following sheet for detailed information.
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Parameter Function
It is to set device name.

Device g _ ,

Name Note: Different devices have different names.
Video This is to display video standard such as PAL.
Standard

Language You can select the language from the dropdown list.

TV Out You can open or close the function, it can only be supported by the
devices with TV Out.

® Intelligent function will be disabled when TV Out is opened.
® |t will auto close TV Out when intelligent function is enabled.
® Some devices support SDI and HDCVI.

The Date & Time interface is shown as in Figure 6-105.

@lhua

Date&Time

Camera General

NSO Date Format Year-Month-Day [+]
Event

Time Format 24-Hour-based System [~ |
Storage

Time Zone GMT+06:00 E
System

urrent Time 2000 - 05 22 19 37 19

> Account [ DST Enable
S PTZ Settings DST Type @ Date ) Week
> Default Start Time Jan =] 1 [=]| o0 : o0 :
> Import/Export End Time Jan E‘ 2 Iz‘ oo - 00 -
> Auto Maintain [] Synchronize with NTP
> Upgrade NTP Server clock.isc.org
Information Port 123

Update Period 10 Minute (0~30)

Detaut || Reesn || saw

Figure 6-105

Please refer to the following sheet for detailed information.

Parameter Function
Here you can select date format from the dropdown list.

Date format

Time There are two options: 24-H and 12-H.

Format

The time zone of the device.

Time zone
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Current It is to set system time. It becomes valid after you set.

Time

Sync PC You can click this button to save the system time as your PC current
time.

DST Enable | Here you can set both begin and end time of daylight saving time.

You can set according to the date format or the week format.

Synchronize

You can check the box to enable NTP function.

with NTP

NTP server | You can setthe time server address.

Port Itis to set the time server port.

Update It is to set the sync periods between the device and the time server.
period

6.5.2 Account

For user name and user group, the max length is 31 characters, which can be made up of digit,

letter, underline, hyphen, dot and @.

Password can be 0~32 characters in number and letter only. User can modify other user's

password.

User and group can be manually added to 18 and 8 respectively.
User management adopts group/user modes. The user name and the group name shall be unique.
One user shall be included in only one group.

Currently logged in user cannot change his/her own right.

6.5.2.1 Username
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In this interface you can enable anonymity login, add/remove user and modify user name. See Figure
6-106.

@lhua

Camera Account

b [C] Anonymous Login
Esnt User Name Group
Storage No. Group Name Remark Modify Delete
1 admin admin admin 's account 4 (=]
> General
Account
» PTZ Settings
» Default
> Import/Export
> Auto Maintain
» Upgrade -
Information Authority List
Live Playback Record Control Backup PTZ Account
Alarm Log Search Clear Log Upgrade Auto Maintain General
Video/Audio Schedule/Destinaticn MNetwork Abnomality Video Detect PTZ Settings
Default/lmport/Export Conditions VS
Figure 6-106

Enable anonymity login: Enable anonymity login, and input IP. No username or password is required,
you can log in by anonymity (with limited rights). You can click logout to end your session.

Add user: Itis to add a name to group and set the user rights. See Figure 5-86.

Hidden user “default” is for system interior use only and cannot be deleted. When there is no login user,
hidden user “default” automatically login. You can set some rights such as monitor for this user so that
you can view some channel view without login.

Here you can input the user name and password and then select one group for current user.

Please note the user rights shall not exceed the group right setup.

For convenient setup, please make sure the general user has the lower rights setup than the admin.
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Add User x|

Lser Mame
Fassword

Confirm Password

Group Iatlmin j

Femark

Authority List ¥ Al
W Live i’
M Playback

M Record control

W Backup &l

Save Cancel

Figure 6-107

Modify user

It is to modify the user property, belonging group, password and rights. See Figure 6-108.

Modify password

It is to modify the user password. You need to input the old password and then input the new password
twice to confirm the new setup. Please click the OK button to save.

Please note, the password ranges from 0-digit to 32-digit. It shall include the number and letter only. For
the user who has the account rights, he can modify the password of other users.
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Modify User | X |
User Mame |admin j
™ Modify Password
Eroup |a:lmin j
Remark admin s account
Authority List F A

F Live ﬂ

¥ Playback
¥ Record control

¥ Backup ~|

Save Cancel

Figure 6-108

6.5.2.2 Group
The group management interface can add/remove group, modify group password and etc.

The interface is shown as in Figure 6-109.

aJhua

TECHNOLOGY

Camera Account

Network -
[7] Anonymous Login

Event
User Name

Storage

1 admin administrator group
> General 2 user user group
> PTZ Settings
> Default
> Import/Export
> Auto Maintain
> Upgrade -
Information Authority List
Live Playback Record Control Backup PTZ Account
Alarm Log Search Clear Log Upgrade Auto Maintain General
Video/Audio Schedule/Destination Network Abnormality Video Detect PTZ Settings
Default/r Ci i Vs
Add Group

Figure 6-109

Add group: Itis to add group and set its corresponding rights. See Figure 6-110.

141



Calaya Dahua Network Camera Web 3.0 Operation Manual

Please input the group name and then check the box to select the corresponding rights. It includes:

preview, playback, record control, PTZ control and etc.

Add Group

Group
Remark

Autharity List

Modify group

Click the modify group button, you can see an interface is shown as in Figure 6-111.

™ an
™ Live i’
" Playback
I Record control
™ Backup =l
Save Cancel
Figure 6-110

Here you can modify group information such as remarks and rights.

6.5.3 PTZ

Modify Group

Group IEE|I'|'|iI'| j

Remark administrator group

Autharity List I Al
¥ Live i’
¥ Playback
¥ Record contral
¥ Backup =l

Save Cancel
Figure 6-111

Please note only some series products support this function.
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The PTZ settings interface is shown as in Figure 6-112.

Protocol
Address
Baudrate
Data Bit

> Account Stop Bit

PTZ Settings

> Default

Parity

> Impor/Export
> Auto Maintain

> Upgrade

Information

PTZ Settings

PELCOD
1
9600

B G EE]

Figure 6-112
Please refer to the following sheet for detailed information.
Parameter | Function
Protocol Select the corresponding dome protocol.
Address Set corresponding dome address. Default value is 1.
Please note your setup here shall comply with your dome address;
otherwise you cannot control the speed dome.
Baud Select the dome baud rate. Default setup is 9600.
Rate
Data Bit Default setup is 8.
Stop bit Default setup is 1.
Parity Default setup is none.
6.5.4 Default

The default setup interface is shown as in Figure 6-113.
Please note system cannot restore some information such as network IP address, account and so on.
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Camera
Network

Event

Storage

> General
> Account
> PTZ Settings
> Import/Export
> Auto Maintain
> Upgrade

Information

Figure 6-113

6.5.5 Import/Export
The interface is shown as in Figure 6-114.

@lhua

Camera Import/Export

LT Backup Path

Event

Storage mpot [ expot

> General

» Account

> PTZ Settings

> Default
> Auto Maintain
> Upgrade

Information

Figure 6-114

Please refer to the following sheet for detailed information.

Parameter | Function
It is to import the local setup files to the system.

Import

Export It is to export the corresponding system setup to your local PC.

5.5.6 Remote control

Note:
It is supported by some devices.
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anua | ive | Papsck [ sewp | Aam [ Logowt |

Camera Remote @

Network

Event Leamn Remote > | Leamn I | Clear |
Storage
- Arm/Disarm |Arm :] l 10s j

>

> Account

> Default

> Import/Export

> Auto Maintain

> Upgrade

Information

Figure 6-115
Parameter Function
Learn Bind remote control or wireless alarm with equipment.
Clear Unbind remote control with equipment.

Start arm after the time you choose, disarm comes into effect immediately. Note:

Arm/Disarm With disarm status, all the following alarms won’t trigger: motion detect alarm,
masking alarm, local alarm, PIR alarm, wireless alarm.

6.5.6 Auto Maintenance

The auto maintenance interface is shown as in Figure 6-116.

Here you can select auto reboot and auto delete old files interval from the dropdown list.
If you want to use the auto delete old files function, you need to set the file period.

Auto Maintain

Auto Reboot Tuesday

[[] Auto Delete Old Files
Storage

System Manual Reboot

» General |

Refresh ‘ | Save

> Account

> PTZ Settings
> Default

> Import/Export
> Upgrade

Information

Figure 6-116
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Parameter Function

Auto Reboot Check it and set auto reboot time.

Auto Delete Old

Eiles Check it and set period within 1~31 days.

6.5.7 Upgrade

The upgrade interface is shown as in Figure 6-117.

Please select the upgrade file (file extension is “.bin”) and then click the update button to begin firmware
update.

Important

Improper upgrade program may result in device malfunction!

@Jhua

Camera Upgrade

Network Select Firmware File

Event

Storage

> General
> Account
> PTZ Settings
> Default
> Import/Export
> Auto Maintain

Information

Figure 6-117

6.6 Information

6.6.1 Version
The version interface is shown as in Figure 6-118.
Here you can view system hardware features, software version, release date and etc. Please note the

following information is for reference only.

@Jhua

Camera Version

Network

Device Type IPC-HF 3300

Event
Software Version 2.420.0000.0.R, build : 2014-03-14

Storage
WEB Version 321175653
System

Version

> Log

ONVIF Version 241

SIN PZC1EW24200002

Copyright 2011,All Rights Reserved,

> Online User

Figure 6-118
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6.6.2 Log
Here you can view system log. See Figure 6-119.

Network
Event
Storage
System

nformation
> Version

> Online User

Start Time | 2014 -

No.

03 - 30 11 - 17 © 02 End Time | 2014 -

Log Time User Name Event

Detailed Information

M<i/ip PcaTo (=)
Figure 6-119
Please refer to the following sheet for log parameter information.
Parameter | Function
Start time Set the start time of the requested log. (The earliest time is 2000/1/1)
End time Set the end time of the requested log. (The latest time is 2037/12/31)
Type Log type.
Search You can select log type from the drop down list and then click search
button to view the list.
You can click the stop button to terminate current search operation.
Log You can select one item to view the detailed information.
information
Clear You can click this button to delete all displayed log files. Please note
system does not support clear by type.
Backup You can click this button to backup log files to current PC.

6.6.3 Online User

The online user interface is shown as in Figure 6-120.
Here you can view current online user, group name, IP address and login time.
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@Jhua

Camera
Network o
Event 1

Storage

Online User

User Login Time
2000-05-22 18:33:46

IP Address
10.18.116.47

User Local Group

admin admin

System

> Version

> Log

Figure 6-120
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Please note some series product does not support this function.
Click alarm function, you can see an interface is shown as in Figure 7-1.
Here you can set device alarm type and alarm sound setup.

(T ST ST U ST

@Jhua

Alarm Type

[T] Motion Detection
[] Disk Error

[] External Alarm
[7] Audio Detection

[ Scene Changing
Operation

[T Prompt
Alarm Tone

[] Play Alarm Tone

Tone Path

[”] DiskFull

[] Video Tampering

[] Megal Access

[[]ivs

Alarm Type

@

Alarm Channel

Figure 7-1

Please refer to the following sheet for detailed information.

Type

Parameter

Function

Alarm

type

Motion detection

System alarms when motion detection alarm
occurs,

Disk full System alarms when disk is full.

Disk Error System records alarm info when disk error
happens.

Video System alarms when video is tampering.

Tampering

External alarm Alarm input device sends out alarm.

lllegal Access System alarms when there is illegal access.

Audio Detection

System alarms when there is audio detect.

IVS

System alarms when IVS event is triggered.

Scene Changing

System will record alarm info when triggering
scene changing.
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Type

Parameter

Function

Operation

Prompt

.|

When alarm is triggered, there will be s /|
inmain menu of alarm interface and system
automatically records alarm info. The icon
disappears when user click on alarm menu bar.
Note:

If alarm interface is displayed, when alarm is
triggered, there will be no image prompt, but alarm
record will be in list on the right.

Alarm
Tone

Play Alarm Tone

Click it and select the path of audio file to be
played in the tone path, when the subscribed alarm
event triggers, it will play the selected audio file to
prompt that there is alarm event which has been
triggered.

Tone Path

You can customize the storage path of the alarm
tone.
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8 Log out

Click log out button, system goes back to log in interface. See Figure 8-1.

N
[ ]
[ ]

Usemame: | admin

Password: '

Figure 8-1

ote
This manual is for reference only. Slight difference may be found in user interface.
All the designs and software here are subject to change without prior written notice.

All trademarks and registered trademarks mentioned are the properties of their respective

owners.
If there is any uncertainty or controversy, please refer to the final explanation of us.
Please visit our website for more information.

@hua

Zhejiang Dahua Vision Technology Co., Ltd

A
p

ddress: No.1199 Bin’an Road, Binjiang District, Hangzhou, PRC.
ostcode: 310053

Tel: +86-571-87688883
Fax: +86-571-87688815

E

mail:overseas@dahuatech.com

Website: www.dahuasecurity.com
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